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License Agreement
THIS END-USER LICENSE AGREEMENT (“LICENSE”) IS A LEGAL AGREEMENT BETWEEN YOU AND GARMIN LTD. 
(“GARMIN”). ALL GARMIN SOFTWARE AND THIRD PARTY SOFTWARE THAT IS (i) INSTALLED IN THE PRODUCT AND/OR (ii) 
RECORDED IN MEDIA ATTACHED TO THE PACKAGE OR INCLUDED IN THE PACKAGE OF THE PRODUCT (EXCEPT AS MAY 
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PROTECTED UNDER COPYRIGHT LAWS AND INTERNATIONAL COPYRIGHT TREATIES. THE SOFTWARE IS LICENSED, NOT 
SOLD. THIS SOFTWARE IS PROVIDED UNDER THE FOLLOWING LICENSE WHICH DEFINES WHAT YOU MAY DO WITH THE 
PRODUCT AND CONTAINS LIMITATIONS ON WARRANTIES AND/OR REMEDIES.
IMPORTANT: CAREFULLY READ THIS LICENSE BEFORE USING THIS PRODUCT. INSTALLING, COPYING, OR OTHERWISE 
USING THIS PRODUCT INDICATES YOUR ACKNOWLEDGMENT THAT YOU HAVE READ THIS LICENSE AND AGREE TO 
ITS TERMS. IF YOU DO NOT AGREE, RETURN THE COMPLETE PRODUCT TO: GARMIN INTERNATIONAL, INC. CUSTOMER 
SERVICE, 1200 EAST 151st STREET, OLATHE, KS 66062; OR GARMIN (EUROPE) LTD., UNIT 5, THE QUADRANGLE, ABBEY PARK 
INDUSTRIAL ESTATE, ROMSEY, SO51, 9DL, U.K.; OR GARMIN CORPORATION, NO. 68, JANGSHU 2ND ROAD, SHIJR, TAIPEI 
COUNTY, TAIWAN; WITHIN 10 DAYS OF THE DATE YOU ACQUIRED IT FOR A FULL REFUND.
1. LICENSE: Garmin (“we” or “us”) provides you with storage media containing the Software which may also include digital cartographic 
data, “online” or electronic documentation and printed materials (together called the “Product”) and grants you a limited non-exclusive license 
to use the Product in accordance with the terms of this License Agreement. The copyright and all other rights to the Product shall remain with 
us (and our licensors, as applicable). You must reproduce any copyright or other notice marked on the Product on all copies you make.
2. YOU MAY: 
a) install and use one copy of the Product on a single computer or network. This copy is to be used by only a single user at a time. If you wish to 
use the Product for more users, you will need an additional license for each user. 
b) make one copy of the Product for archive or backup purposes.
c) use a copy of the Product on a home or portable computer if that copy is never loaded at the same time it is loaded on your primary computer.
d) transfer the Product to someone else only if you assign all of your rights under this License, cease all use of the Product, erase or destroy any 
copy (including the hard disk copy) made in support of your use of the Product, and ensure that the other person agrees IN WRITING to the 
terms of this License.
3. YOU MUST NOT:
a) make copies of, or provide access to, the Product except as expressly permitted in Section 2 of this License. 
b) translate, reverse engineer, decompile, or disassemble the Product except to the extent the foregoing restriction is expressly prohibited by 
applicable law.
c) rent, lease, loan, sub-license, distribute, assign, or transfer the Product or any unlock code for the Product except as set out in Section 2 (d) 
above.
d) modify the Product or merge all or any part of the Product with another program.
e) use the Product for any unlawful purpose or in any illegal manner. 
4. TERM: This License shall continue for as long as you use the Product. However, this License will terminate automatically without notice 
from Garmin if you fail to comply with any of its terms or conditions. You must agree, upon termination, to destroy all copies of the Product. 
The Limitations of Warranties and Liability set out below shall continue in force even after any termination.



5. LIMITATION OF WARRANTIES AND LIABILITY: THE PRODUCT IS PROVIDED ON AN “AS IS” BASIS, WITHOUT ANY 
WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR ANY WARRANTY ARISING BY LAW, STATUTE, USAGE 
OF TRADE, OR COURSE OF DEALING. YOU ASSUME ALL RESPONSIBILITY AND RISK FOR THE USE OF THIS PRODUCT 
AND GARMIN DISCLAIMS ALL LIABILITY FOR ANY LOSS, INJURY OR DAMAGE RESULTING FROM USE OF THIS PRODUCT, 
WHETHER DIRECT OR INDIRECT, AND WHETHER OR NOT GARMIN HAS BEEN ADVISED OF OR HAS KNOWLEDGE OF 
THE POSSIBILITY OF SUCH LOSS, INJURY OR DAMAGE. IN NO EVENT SHALL GARMIN HAVE ANY LIABILITY TO YOU 
OR ANY OTHER PERSON OR ENTITY FOR ANY COMPENSATORY, INDIRECT, INCIDENTAL, SPECIAL, CONSEQUENTIAL, 
OR EXEMPLARY DAMAGES WHATSOEVER, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOST OR 
DAMAGED DATA, OR OTHER COMMERCIAL OR ECONOMIC LOSS, EVEN IF WE HAVE BEEN ADVISED OF THE  
POSSIBILITY OF SUCH DAMAGES, OR THEY ARE FORESEEABLE. WE ARE ALSO NOT RESPONSIBLE FOR CLAIMS BY A 
THIRD PARTY. OUR MAXIMUM AGGREGATE LIABILITY TO YOU SHALL NOT EXCEED THE AMOUNT PAID BY YOU FOR THE 
PRODUCT. THE LIMITATIONS IN THIS SECTION SHALL APPLY WHETHER OR NOT THE ALLEGED BREACH OR  
DEFAULT IS A BREACH OF A FUNDAMENTAL CONDITION OR TERM OR A FUNDAMENTAL BREACH. Some states do not allow 
the exclusion of incidental or consequential damages or the limitation of duration of an implied warranty so the above limitations may not apply 
to you. 
IT IS YOUR RESPONSIBILITY TO USE THIS PRODUCT PRUDENTLY AND TO VISUALLY VERIFY STREETS, ROADS, ROAD 
SIGNS, AND DIRECTIONS. THIS PRODUCT IS INTENDED TO BE USED ONLY AS A TRAVEL AID AND SHOULD NOT BE USED 
FOR ANY PURPOSE REQUIRING PRECISE MEASUREMENT OF DIRECTION, DISTANCE, OR LOCATION. DO NOT  
ATTEMPT TO ENTER INFORMATION INTO THE PRODUCT, OR CONTROL THE PRODUCT, WHILE OPERATING A VEHICLE.
6. U.S. GOVERNMENT RESTRICTED RIGHTS. (I) THE PRODUCT and documentation are provided with RESTRICTED RIGHTS. 
Use, duplication, or disclosure by the United States Government is subject to restrictions as set forth in subparagraph (c)(1) and (2) of the 
Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19, as applicable. Manufacture/Contractor is Garmin International, Inc., 
1200 East 151st Street, Olathe, KS 66062. (II) All Garmin technical data and computer software is commercial in nature and developed solely at 
private expense. Software is delivered as Commercial Computer Software as defined in DFARS 252.227-7014 (June 1995) or as a commercial 
item as defined in FAR 2.101(a) and as such is provided with only such rights as are provided in Garmin’s standard commercial license for such 
software. Technical data is provided with limited rights only as provided in DFARS 252.227-7015 (Nov. 1995) or FAR 52.227-15 (June 1987), 
whichever is applicable. 
7. EXPORT CONTROLS: You agree not to export or re-export the Product to any country in violation of the export control laws of the United 
States of America.
8. GARMIN LICENSORS: With respect to Third Party Software contained in the Product, the provisions of this License shall inure to the 
benefit of the licensors to Garmin of third party software contained in the Product. Such licensors shall be third party beneficiaries hereof, and 
shall have the right to enforce any and all rights and claims arising hereunder with respect to such third party software, including the right to 
bring an action directly against you, in the event of a breach by you of your obligations hereunder.
9. GENERAL: This License is the entire agreement between us, superseding any other agreement or discussions, oral or written, and may 
not be changed except by a signed agreement. This License shall be governed by and construed in accordance with the laws of the State of 
Kansas, United States of America. If any provision of this License is declared by a court of competent jurisdiction to be invalid, illegal, or 
unenforceable, such a provision shall be severed from the License and the other provisions shall remain in full force and effect.
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Limited Warranty
The iQue® M5 is warranted to be free from defects in materials or workmanship for one year from the date of purchase. Within this period, 
Garmin will, at its sole option, repair or replace any components that fail in normal use. Such repairs or replacement will be made at no charge 
to the customer for parts or labor, provided that the customer shall be responsible for any transportation cost. This warranty does not cover 
failures due to abuse, misuse, accident, or unauthorized alteration or repairs.
THE WARRANTIES AND REMEDIES CONTAINED HEREIN ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES 
EXPRESS OR IMPLIED OR STATUTORY, INCLUDING ANY LIABILITY ARISING UNDER ANY WARRANTY OF MERCHANT-
ABILITY OR FITNESS FOR A PARTICULAR PURPOSE, STATUTORY OR OTHERWISE. THIS WARRANTY GIVES YOU SPECIFIC 
LEGAL RIGHTS, WHICH MAY VARY FROM STATE TO STATE.
IN NO EVENT SHALL GARMIN BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES, 
WHETHER RESULTING FROM THE USE, MISUSE, OR INABILITY TO USE THIS PRODUCT OR FROM DEFECTS IN THE 
PRODUCT. Some states do not allow the exclusion of incidental or consequential damages, so the above limitations may not apply to you.
Garmin retains the exclusive right to repair or replace the unit or software or offer a full refund of the purchase price at its sole discretion. 
SUCH REMEDY SHALL BE YOUR SOLE AND EXCLUSIVE REMEDY FOR ANY BREACH OF WARRANTY.
To obtain warranty service, call your local Garmin authorized dealer. Or call Garmin Product Support at one of the numbers listed below for 
shipping instructions and an RMA tracking number. The unit should be securely packed with the tracking number clearly written on the outside 
of the package. The unit should be sent, freight charges prepaid, to any Garmin warranty service station. A copy of the original sales receipt is 
required as the proof of purchase for warranty repairs.
Products sold through online auctions are not eligible for rebates or other special offers from Garmin. Online auction confirmations are not 
accepted for warranty verification. To obtain warranty service, an original or copy of the sales receipt from the original retailer is required. 
Garmin will not replace missing components from any package purchased through an online auction.

 Garmin International, Inc. Garmin Europe, Ltd. 
 1200 E. 151st Street  Unit 5, The Quadrangle, Abbey Park Industrial Estate 
 Olathe, KS 66062, U.S.A. Romsey, SO51, 9DL, U.K. 
 Phone: 800/800.1020  Phone: 44/0870.8501241 
 Fax: 913/397.0836  Fax: 44/0870.8501251

Limited Warranty
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Lithium-Ion Polymer Battery Information
Your iQue M5 contains a replaceable lithium-ion polymer battery. Please observe the following cautions:

• Do not store at or use the unit or battery in temperatures above 60° C (140° F). Do not store or use the unit or battery near a heat source, 
such as a radiator, stove, fireplace, or other heat-generating source. If the unit or battery are exposed to temperatures above 60° C  
(140° F), the battery in the unit could explode or vent, posing a risk of fire.

• Do not use any chargers not specified by Garmin. Do not charge the battery under conditions not specified by Garmin, as it may leak 
electrolytes, become hot, or explode.

• Do not put the unit and battery into a fire, as it may swell or explode. Do not use near any type of heat source. If the battery leaks 
electrolytes or emits a strange smell, discontinue use and move the unit or battery away from the heat source.

• Do not submerge the unit or battery in water or any type of liquid. Do not expose the unit or battery to any type of water, such as rain or 
moisture, as it might  corrode, become hot, or occasionally not function.

• Keep the unit and battery out of reach of babies and children to avoid any accidents.
• Do not put the unit or battery in a microwave oven or pressure cooker.
• Although rechargeable, the battery has a limited life-span. Replace when usage time between charges become short.
• If there are any problems with the battery, keep the battery in a safe place and immediately contact Garmin.
• If the battery must be disposed of, contact your local waste disposal department for information on properly disposing of  

lithium-ion polymer batteries.
• Do not store the battery in a pocket or bag together with metallic objects such as keys, necklaces, hairpins, coins, or screws.
• Do not pierce the battery with a sharp object, such as a needle or screwdriver.
• Do not disassemble the battery or modify the battery design, including the electric circuit.
• Do not hit the battery with a heavy object. Do not step on the battery, throw it, or drop it on a hard surface.
• Do not heat any area of the battery with a heated object, such as a soldering iron.

Warnings
WARNING: This product, its packaging, and its components contain chemicals known to the State of California to cause cancer, birth defects, 
or reproductive harm. This Notice is being provided in accordance with California’s Proposition 65. If you have any questions or would like 
additional information, please refer to our Web site at http://www.garmin.com/prop65. 
The iQue M5 has no user-serviceable parts. Should you ever encounter a problem with your unit, please take it to an authorized Garmin dealer 
for repairs. 
The iQue M5 is fastened shut with screws. Any attempt to open the case to change or modify the unit in any way will void your warranty and 
may result in permanent damage to the equipment.

Lithium-Ion Polymer Battery Information

http://www.garmin.com/prop65
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CHAPTER 1: GETTING STARTED

Introduction
Congratulations on purchasing an iQue® M5! Using your new iQue M5, you can keep your most important business and personal 
information up-to-date and close at hand. Microsoft® ActiveSync® increases the power of your device by allowing you to 
synchronize the information on your desktop or laptop computer with your device. Picture yourself in the following situations:

• While you are walking with a colleague, your cell phone rings, and your manager asks if you two are free this afternoon for 
an emergency meeting. While your colleague fumbles through his paper organizer, you press a button on your device and 
instantly see a list of today’s appointments and meetings. You are quickly able to tell your manager your available times. For 
more information on scheduling appointments and meetings, see Chapter 3.

• You are meeting your friends tonight for dinner and a movie. You download the latest movie information from the Internet 
to your desktop computer and then synchronize it with your device. At dinner, you pull out your iQue M5 and review your 
movie options with your friends. For more information on downloading Web pages to your device, see Chapter 7.

• A Calendar reminder alerts you that it is time to catch the bus. You grab your iQue M5 and catch the bus just in time. Because 
ActiveSync keeps the information on your device up-to-date, you leisurely review your task list, make notes about the new 
books and CDs you want to buy, and read and respond to e-mail messages. When you get back to the office, ActiveSync 
transfers any task changes you made, your notes, and your e-mail message responses to your desktop computer. For more 
information on ActiveSync, see Chapter 2.
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Get to Know Your iQue M5
Your iQue M5 has easy-to-use buttons that open programs and a stylus for selecting items and entering information.

SD Card SlotAudio Jack

External Antenna 
Connector (covered by 

weather cap)

Infrared (IR) Window

Stylus

GPS Antenna Release

GPS Antenna

Stylus

Reset button (on bottom of unit)

Removable battery door

Microphone/Speaker

Power button

Battery Status LED

Bluetooth Status LED

Calendar button

Contacts button Messaging button

Que button

Scroll button

REC button  
(on side of unit)
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Using the Stylus
On your device, use the stylus to select items just as you would use a mouse on your personal computer.

• Tap—Touch the screen once with the stylus to open items and select options.
• Drag—Hold the stylus on the screen and drag across the screen to select text and images. Drag the stylus in a list to select 

multiple items. If you select an item by accident, drag the stylus away from the item to deselect.
• Tap and Hold—Tap and hold the stylus on an item to see a pop-up menu for that item. Before the menu appears, you  

will see a blue circle of dots that indicates you are opening a menu. On the pop-up menu that appears, tap the action you  
want to perform.

The Today Screen
When you turn on your device for the first time each day (or after 4 hours of inactivity), you will see the Today screen. You can also 
display it by tapping Start  and then Today. On the Today screen, you can see important information for the day at a glance.

Shows your next 
upcoming  

appointment.

Tap to view your 
active tasks.

Tap to view your messages.

Tap to open a program.

Tap to change date and time.

Tap to change 
owner information.

Tap to enable Bluetooth or 
open Bluetooth software.

Tap to change volume of sounds

Tap to view connection status.

Tap to create a 
new item.

Tap each shortcut to open a 
program.

Shows current GPS status.

Tap to open System Status window.
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Opening Programs
You can switch from one program to another by selecting it from the Start  menu. (You can customize which programs you see 
on this menu. For information, see “To place programs in the Start Menu,” Chapter 10.) To access some programs, you need to tap 
Start , Programs, and then the program name. 

You can also switch to some programs by pressing the program buttons on your device or by tapping the program icon in the 
Shortcut bar on the Today screen.

The following table contains a partial list of programs installed on your iQue M5. You can install additional applications at  
http://www.microsoft.com/windowsmobile or from the Companion CD.

Icon Program What You Can Do

ActiveSync Synchronize information between your iQue M5 and  
desktop computer.

Calculator Perform basic arithmetic and computations.

Calendar Keep track of your appointments and create  
meeting requests.

Contacts Keep track of your friends and colleagues.

Messaging Send and receive e-mail messages.

MSN Messenger Send and receive instant messages with your MSN 
Messenger contacts.

Notes Create handwritten or typed notes, drawings, and recordings.

Pictures Manage and manipulate image files.

Pocket Excel Create new workbooks or view and edit Excel workbooks 
created on your desktop computer.

Pocket MSN Browse Web and WAP sites and download new programs 
and files from the Internet.

Pocket Word Create new documents or view and edit Word documents 
created on your desktop computer.

Que™ View your current position on the map, create and save 
Locations in memory, and navigate routes.

Tasks Keep track of your tasks.

Terminal Services Client Remotely access files and information on a Windows 
NT/2000/XP Server.

Windows Media Player 10 Play multimedia content (videos and sound files).

http://www.microsoft.com/windowsmobile


Getting Started: Get to Know Your iQue M5

5Chapter 1: Getting Started

Navigation Bar and Command Bar
The navigation bar is located at the top of the screen. It displays the active program and current time and allows you to switch 
between programs and close screens. 

The Navigation Bar

Use the command bar at the bottom of the screen to perform tasks in programs. The command bar includes menu names, buttons, 
and the Input Panel button . To create a new item in the current program, tap New. To open a menu or see what action a button 
performs, tap and hold the stylus on the button. If you do not want to activate the button, simply tap anywhere outside the menu or 
drag the stylus away from the button.

The Command Bar

Input Panel button

Pop-up Menus
Pop-up menus allow you to perform actions quickly and easily. For example, you can open a pop-up menu in the Contact list and 
quickly delete a contact, make a copy of a contact, or send an e-mail message to a contact. The actions in pop-up menus vary from 
program to program. To access a pop-up menu, tap and hold the stylus on any item in a list. A blue circle of dots appears to show 
you where you are pressing on the screen. When the menu appears, lift the stylus and tap the action you want to perform. Tap 
anywhere outside the menu to close the menu without selecting any of the options.

An example of a pop-up menu.

Notifications
Your iQue M5 helps you remember appointments, tasks, and alarms in a variety of ways. You may see or hear any of the following 
notifications:

• A message box that appears on the screen.
• A sound (which you can specify). You can also set the unit to vibrate instead of playing a sound.
• A flashing light on the upper right-hand corner of the iQue M5. 

See “To change notifications” in Chapter 10 to change the way your iQue M5 notifies you of upcoming events.
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Entering Information on Your iQue M5
You have several options for entering new information:

• Use the input panel to enter typed text, either by using the soft keyboard or another input method.
• Write directly on the screen.
• Draw pictures on the screen.
• Speak into your device microphone to record a message. 
• Use ActiveSync to synchronize or copy information from your desktop computer to your device. For more information on 

ActiveSync, see Chapter 2.

Entering Text Using the Input Panel
Use the input panel to enter information in any program on your device. You can type using the soft keyboard or write using  
Letter Recognizer, Block Recognizer, or Transcriber. When using each input panel method, the characters appear as typed text on 
the screen.

To show or hide the input panel, tap the Input Panel button . Tap the arrow next to the Input Panel button to choose a method for 
typing or writing.

When you use the input panel, your device anticipates the word you are typing or writing and displays it above the input panel. 
When you tap the displayed word, it is inserted into your text at the blinking cursor. As you continue to use your device, it learns to 
anticipate more and more words.

Tap here if this is 
the right word.

With the soft keyboard, you can tap letters to enter information. Letter Recognizer allows you to write letters using the stylus just as 
you would on paper. With Block Recognizer you can input character strokes with the stylus that are similar to those used on other 
devices. Using Transcriber you can write anywhere on the screen with the stylus, just as you would on paper. Write a sentence or 
more of information, then pause and let Transcriber change the written characters to typed characters.

To type with the soft keyboard:
1. Tap the arrow next to the Input Panel button  and then tap Keyboard.
2. On the soft keyboard that is displayed, tap the keyboard keys with your stylus.
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To write with Letter Recognizer:
1. Tap the arrow next to the Input Panel button and then tap Letter Recognizer.
2. Write letters in the box just as you would write on paper.

Letter Recognizer

To write with Block Recognizer:
1. Tap the arrow next to the Input Panel button and then tap Block Recognizer.
2. Write a letter in the box.

Block Recognizer

To write with Transcriber:
1. Tap the arrow next to the Input Panel button and then tap Transcriber.
2. Write anywhere on the screen.

Transcriber

Editing Text
If you want to edit or format typed text, you must select it first. Simply drag the stylus across the text you want to select. You can 
cut, copy, and paste text by tapping and holding the selected words and then tapping the appropriate command on the pop-up menu. 
You can also use the Edit menu.
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Entering Dates
Many applications ask you for a date as input, such as “June 18, 2006.” All standard Windows Mobile™-based applications use the 
same form to assist in this process.

Entering a date on the calendar.

To enter dates:
1. Tap the date field you want to change.
2. Tap the left or right arrows at the top of the calendar to move between months. You can also tap the month and 

choose a specific month from a menu.
3. Tap the year, and then tap the up and down arrows to change the year. You can also use the Input Panel to  

enter a year.
4. Tap the day on the calendar to select the date you want. Tap Today to choose today’s date.

Writing on the Screen
In the Notes program and in the Notes tab in Calendar, Contacts, and Tasks, you can use your stylus to write directly on the screen. 
Write the way you do on paper. You can edit and format what you have written and convert the information to text at a later time.

To write on the screen:
1. Tap the Pen icon  to switch to writing mode. 
2. Write anywhere on the screen.

To select writing:
1. Tap and hold the stylus next to the text you want to select until the cursor appears.
2. Without lifting, drag the stylus across the text you want to select.

To convert writing to text:
1. Select the writing you want to convert to text. (This is necessary only if you wish to convert part of your writing rather 

than all of it.)
2. Tap Tools and then tap Recognize.

If the conversion is incorrect, you can select different words from a list of alternates or return to the original writing. 

To select alternate words:
1. Tap and hold the incorrect word (tap one word at a time). 
2. From the pop-up menu, tap Alternates. A menu with a list of alternate words appears. 
3. Tap the word you want to use or tap the writing at the top of the menu to return to the original writing.
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Try these tips for good recognition:
• Write neatly.
• Write on the lines and draw descenders below the line. Write the cross of the “t” and apostrophes below the top line so that 

they are not confused with the word above. Write periods and commas above the line.
• For better recognition, try increasing the zoom level to 300% using the Tools menu.
• Write the letters of a word closely and leave big gaps between words so the device can easily tell where words begin and end.
• Note that hyphenated words, foreign words that use special characters such as accents, and some punctuation cannot  

be converted.
• Note that you cannot change words that have already been recognized by writing over them with the stylus. 

Drawing on the Screen
You can draw on the screen in the same way that you write on the screen. The difference between writing and drawing on the screen 
is how you select items and how they can be edited. For example, selected drawings can be resized, whereas writing cannot.

To create a drawing, select the Pen icon  and simply cross three ruled lines on your first stroke. A drawing box appears. 
Subsequent strokes inside or touching the drawing box become part of the drawing. Drawings that do not cross three ruled lines will 
be treated as writing.

To edit a drawing:
1. Tap and hold the stylus on the drawing until the selection handle (looks like a “+”) appears.
2. Drag the selection handle to select the drawing.
3. Tap and drag to move the drawing.
4. Tap the Edit menu or tap and hold on the drawing to cut, copy, or paste the drawing.

Recording a Message
In any program where you can write or draw on the screen, you can also quickly capture thoughts, reminders, and phone numbers 
by recording a message. In Calendar, Contacts, and Tasks, you can include a recording in the Notes tab. In the Notes program, you 
can either create a stand-alone recording or include a recording in a written note. If you want to include the recording in a note, 
open the note first. In Messaging, you can add a recording to an e-mail message.

Recording in Notes.

To create a recording: 
1. Hold the microphone on your iQue M5 near your mouth or other source of sound.
2. Press and hold the Record hardware button on your device until you hear a beep.
3. While holding down the Record button, make your recording.
4. To stop recording, release the Record button. The new recording appears in the note list or as an embedded icon.
5. To play a recording, tap it in the list or tap the embedded recording icon  in the note.
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Finding Information
The Find feature on your device helps you quickly locate information. Use it to find files or folders, especially large files that may 
be taking up needed space.

To find files, folders, or text:
1. Tap , Programs, and then Find.

2. Tap the Find field and enter the name of the file, folder, or text you want to find.
3. Tap the Type drop-down menu and select what type of file you are searching for.

 
NOTE: If you are trying to find files or folders that are taking up storage space, choose “Larger than 64 KB” from the 
Type menu.

4. Tap Go.
Tap here and enter the 

name of the file or folder 
you are looking for.

Tap to begin 
searching for 

files or folders.
Tap here to specify 
the type of data you 
are searching for.

The results of your 
search appear here.

Organizing Information
You can easily move and organize files and folders with File Explorer. To open, tap , Programs, and then File Explorer. Tap 
and hold to cut, copy, paste, rename, or delete files and folders.

Tap to show hierarchy.  
The dot represents your 
current location. Tap to 

move up in the hierarchy. Shows all files and folders in 
My Documents.

Tap to move, copy, 
delete, rename, or 

beam files or folders.

Tap to open a path.
Tap to view storage card files.

Tap for network sharing.
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CHAPTER 2: ACTIVESYNC

Introduction
Using Microsoft® ActiveSync®, you can synchronize the information on your desktop computer with the information on your iQue 
M5. Synchronization compares the data on your iQue M5 with your desktop computer and updates both computers with the most 
recent information. 

With ActiveSync, you can manage what information is stored on your iQue M5:
• Select which information types are synchronized and control how much data is synchronized.
• Control when synchronization happens.
• Copy (rather than synchronize) files between your device and desktop computer.
• Add or remove programs.
• Back up and restore data.
• Synchronize remotely or with an Exchange server.

You should have already installed ActiveSync on your desktop computer and synchronized for the first time. If you have not done 
this, please refer to the Setup Guide included with the Setup CD for instructions.

Choosing What Data to Synchronize
Because your iQue M5 has a limited amount of storage space (64 MB RAM), we recommend that you limit the amount of 
information you synchronize or store. For example, you can limit the number of Calendar appointments you synchronize between 
your desktop and your iQue M5 to save storage space. You can change these settings on your desktop computer.

To change what types of information to synchronize:
1. Open Microsoft ActiveSync on your desktop computer.
2. Click Options.
3. Click to check the box next to each type of information you want to 

share between your desktop computer and your iQue M5.
4. Click OK.

To limit how much information is synchronized:
1. From ActiveSync on your desktop computer, click Options.
2. Click to highlight Calendar from the list of programs.
3. Click Settings.
4. Check options to limit how many appointments you want to  

synchronize. Click OK.
5. Repeat for each type of information you synchronize.
6. Click OK.

Customize your ActiveSync settings by clicking Options.
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Choosing When to Synchronize
You may find that you want to synchronize less frequently or only at certain times. You can control how often you would like to 
synchronize information by changing settings in ActiveSync on your desktop computer.

To change when synchronization happens:
1. Open Microsoft ActiveSync on your desktop computer.
2. Click Options and then the Schedule tab.
3. Click to choose how often you would like to synchronize information. If you choose “Synchronize manually,” you 

must open ActiveSync and click Sync each time you want to synchronize data.
4. Click OK.

Changing when synchronization happens

Moving Files between Your Desktop Computer and iQue M5
You may want to move files or folders between your desktop and your iQue M5 without having to synchronize that information. 
This works well for files you do not need to update or for files that you cannot synchronize, like pictures. Moving files and folders 
onto your iQue M5 is just like moving them from one location to another on your personal computer. For more help, refer to your 
desktop computer help files.

 NOTE: You may have trouble transferring large files (> 50 MB) to your SD card. This is best done with a separate data 
card reader, rather than transferring them directly to the card in your iQue M5.

To move files or folders:
1. Open ActiveSync on your desktop computer.
2. Click Explore. This window shows all files and folders stored on your iQue M5.
3. To move files to your iQue M5, click and drag files or folders from your desktop computer to this window. You can 

also Cut, Copy, and Paste to move files.
4. To move files to your desktop computer, click and drag files or folders from this window to your desktop computer. 

You can also Cut, Copy, and Paste.

 NOTE: ActiveSync may ned to convert files when synchronizing between your mobile device and the desktop computer. A 
converted file may not contain all the information found in the original file.

Exploring your iQue M5 on your computer
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Adding and Removing Programs
Programs added to your iQue M5 at the factory are stored in ROM (read-only memory). You cannot remove this software, and you 
will never accidentally lose ROM contents. All other programs and data files added to your device after factory installation are 
stored in RAM (random access memory), including any software you load from your iQue M5 setup CD.

You can install any program created for your iQue M5, as long as it has enough memory. The program must be compatible with an 
ARM processor, or it will not work on your iQue M5. Look for programs online at http://www.microsoft.com/windowsmobile.

To add programs:
1. Be sure this program is compatible with your iQue M5 (ARM processor).
2. Download the program to your desktop computer (or insert the CD or disk that contains the program into your desk-

top computer). You may see a single *.cab, *.xip, *.exe, or *.zip file, a Setup.exe file, or several versions of files for 
different device types and processors. Be sure to select the program designed for ARM devices.

3. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs 
provide special installation instructions.

4. Connect your device to your desktop computer.
5. Double-click the *.exe file.

 NOTE: If the file is an installer, the installation wizard will begin. Follow the directions on the screen. Once the software 
has been installed on your desktop computer, the installer will automatically transfer the software to your device. 

 NOTE: If the file is not an installer, you will see an error message stating that the program is valid but it is designed for a 
different type of computer. You will need to move this file to your device. See “Moving Files between your Desktop Com-
puter and your iQue M5.”

6. Once installation is complete, tap Programs, and then the program icon to open.

To add programs directly from the Internet:
1. Open Pocket Internet Explorer on your iQue M5 and connect to the Internet to search for programs you want  

to download.
2. Once you find a program, download it to your iQue M5. You may see a single *.xip, *.exe or *.zip file, a Setup.exe 

file, or several versions of files for different device types and processors. Be sure to select the program designed for 
ARM processors.

3. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs 
provide special installation instructions.

4. Tap the file, such as a *.cab, *.xip or *.exe file. The installation wizard will begin. Follow the directions on the screen.

http://www.microsoft.com/windowsmobile
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To add programs to your Start menu from ActiveSync:
1. Open ActiveSync on your desktop computer.
2. Click Explore.
3. Locate the program file. Right click on the program file name and click Create Shortcut. 
4. Right-click the shortcut and choose Cut. Open My Pocket PC, Windows, and the Start Menu folder. Right-click 

and choose Paste.

To add programs to your Start menu from your iQue M5:
1. Tap  and then Settings.
2. Tap the System tab. Then tap Menus.
3. Tap to check the items you want to include in the  Start menu. Unchecked items appear in the Programs menu.

 NOTE: This method of adding programs only works if a shortcut to the program already appears in the Programs folder. 
To add programs to the Start menu that do not appear in the list, follow the instructions below.

OR
1. Tap , Programs, and then File Explorer.
2. From the pull-down menu, select My Device to view all files and folders on your iQue M5. Locate the program file.
3. Tap and hold on the program file and choose Cut from the pop-up menu.
4. From My Device, tap the Windows folder and then the Start Menu folder. Tap and hold on a blank area inside this 

folder and choose Paste from the pop-up menu.

To remove programs with ActiveSync:
1. Launch ActiveSync on your desktop computer.
2. From the Tools menu, select Add/Remove Programs.
2. Highlight the name of the program you want to remove from your iQue M5.
3. Click Remove.
4. Follow the on-screen instructions.

To remove programs on your iQue M5:
1. Tap , Settings, the System tab, and then Remove Programs.
2. Tap to highlight the program you want to remove; then tap Remove.

 NOTE: If the program does not appear in the list of installed programs, use File Explorer on your device to locate the 
program, tap and hold the program, and then tap Delete on the pop-up menu.
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Backing Up Files and Settings
It is important to back up your iQue M5 files and settings periodically. When you back up files with ActiveSync, you will store an 
“image” of what files, folders, and settings are like on your iQue M5. Then, if you lose data for some reason, you can restore your 
iQue to the last “image” you saved.

You can also back up files and settings on an SD card or in safe storage on your iQue M5. To do so, use Sprite Backup software as 
described in Chapter 9.

Backing up files from your iQue M5 to your computer

To back up files and settings:
1. Open ActiveSync on your desktop computer.
2. From the Tools menu, choose Backup/Restore.
3. Choose whether you want to do a full backup (saves all information) or an incremental backup (saves any informa-

tion that has changed since last backup).
4. Choose where you want to save the back up file. If you want to back up your iQue M5 each time you synchronize, 

check the box next to “Automatically back up each time the device connects.”
5. Click Back Up Now.

 NOTE: Do not use your iQue M5 before you are finished backing up files. If you do, the back up process may fail. 

To restore your iQue M5 to the last backup state:
1. Open ActiveSync on your desktop computer.
2. From the Tools menu, choose Backup/Restore. Click the Restore tab.
3. Click Restore Now.

 NOTE: Any information that has changed on your iQue M5 since your last backup will be erased by the restore process.



ActiveSync: Synchronizing with an Exchange Server

Chapter 2: ActiveSync 17

Synchronizing with an Exchange Server
If your company has installed Microsoft Exchange Server with Exchange Server ActiveSync, you can synchronize between your 
iQue M5 and a server. Note that you can only synchronize with a server or with your desktop computer, not both. 

For more information on setting up and synchronizing with an Exchange server, refer to the ActiveSync help files on your desktop 
(with ActiveSync open, press F1 on your keyboard or choose Microsoft ActiveSync Help from the Help menu). 

Synchronizing Remotely with Infrared
If you have a desktop or laptop with an Infrared (IR) port, you can synchronize remotely with IR. Make sure IR ports on your 
computer and your iQue M5 are lined up with no objects between them. 

To synchronize remotely with IR:
1. Tap  and then ActiveSync on your iQue M5. 
2. Tap Tools and then Connect via IR. ActiveSync will automatically make the IR connection.

Synchronizing after Restoring from Sprite Backup
When you try to synchronize your iQue M5 with your personal computer after restoring data from a Sprite Backup operation, you 
may receive a message like this: “The following information type on your mobile device has items that have not been synchronized 
with this computer before.” This message is expected and unavoidable, even though you have already synchronized data with 
your computer in the past. Choose Combine to add the information on your PC to that on your iQue M5. Replace removes all 
entries from your iQue M5 and resynchronizes everything. In most cases, we recommend that you choose Combine; if you choose 
Replace, you may important delete information that you just restored from Sprite Backup.
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Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Messaging, and Notes. You can use these programs individually or 
together. For example, e-mail addresses stored in Contacts can be used to address e-mail messages in Inbox. 

Using ActiveSync, you can synchronize information in Microsoft Outlook or Microsoft Exchange on your desktop computer 
with your device. You can also synchronize this information directly with a Microsoft Exchange server. Each time you synchronize, 
ActiveSync compares the changes you made on your device and desktop computer or server and updates both computers with the 
latest information. For information on using ActiveSync, see Chapter 2.

You can switch to any of these programs by tapping  and then Programs (if necessary).

Calendar: Scheduling Appointments and Meetings
Use Calendar to schedule appointments, including meetings and other events. To open Calendar, press the Calendar button on the 
front of your iQue M5, or tap  and then Calendar. You can check your appointments in one of several views (Agenda, Day, Week, 
Month, and Year) and easily switch views by pressing the buttons below:

Agenda View Upcoming appointments appear in bold; past 
appointments are not.

Day View View your day’s schedule in one-hour blocks.

Week View View your week’s schedule in one-hour blocks.

Month View View which days of the month contain scheduled 
apppointments.

Year View View a year calendar.
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To create an appointment:
1. If you are in Day or Week view, tap the desired date and time for the appointment.
2. Tap New.

Tap to return to the 
calendar (appointment is 

saved automatically).

Tap to select a date.

Tap to set a time.

Tap to add notes or 
reminders for this 

appointment.

Enter a Subject, and 
then tap to enter a 

Location.

Tap to hide input panel.

3. Tap to select a field. Then enter a description and a location using the input panel.
4. If needed, tap the date and time to change them.
5. Enter other desired information. You will need to hide the input panel or use the scroll bar to see all available fields. 

(Tap  to hide the input panel.)
6. If this appointment occurs more than once, tap the Occurs field and select among the drop-down options.
7. To add notes, tap the Notes tab from the Edit Appointment screen. See “Notes: Capturing Thoughts and Ideas” for 

more information.
8. Tap “Remind Me” to turn on/off the appointment Reminder. Tap to change the time when the reminder will appear.
9. When finished, tap OK to return to the calendar.
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Using the Summary Screen
When you tap an appointment in Calendar, a summary screen appears. To change the appointment, tap Edit. To beam an 
appointment, tap and hold on the appointment and then select Beam Appointment. You can also tap the appointment and then tap 
Tools and Beam Appointment.

Appointment Summary Screen

Creating Meeting Requests
You can use Calendar to set up meetings with users of Outlook or Pocket Outlook. The meeting request is created automatically and 
sent either when you synchronize your Inbox or when you connect to your e-mail server. Indicate how you want to send meeting 
requests by tapping Tools and then Options.

To schedule a meeting:
1. Create an appointment.
2. In the appointment details, hide the input panel  or use the scrollbar and then tap the Attendees field.
3. From the list of e-mail addresses you have entered in Contacts, select the meeting attendees. Then tap ok. The 

meeting notice is created automatically and placed in the Outbox folder of your Inbox. See “Messaging: Sending 
and Receiving E-mail” for more information.
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Contacts: Tracking Friends and Colleagues
Contacts maintains a list of your friends and colleagues so that you can easily find the information you’re looking for, whether 
you’re at home or on the road. Using your iQue M5 infrared (IR) port, you can quickly share Contacts information with other 
device users. You can also integrate your Contacts list with your Locations list in the Que applications (for more information, refer 
to the Que Applications Guide). To open Contacts, press the Contacts button on your iQue M5, or tap  and then Contacts.

To create a contact:
1. Tap New.
2. Using the input panel, enter a name and other contact information. Scroll down to see all available fields.
3. To assign the contact to a category, tap Categories and select a category from the list. 
4. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. See “Notes: Capturing Thoughts 

and Ideas.”
5. When finished, tap OK to return to the contact list.

Scroll to see more fields.

Tap to return to the contact 
list (contacts are saved 

automatically).

Tap each field to enter information.

To find a contact:
1. From the Contacts page, enter all or part of a contact name in the Find a name field.
2. Tap a contact in the list to view information. To show all contacts again, clear the text from the Find a name field or 

tap the button to the right of the field.

Finding a contact.

Using the Summary Screen
When you tap a contact in the contact list, a summary screen is displayed. To change the contact information, tap Edit. To beam a 
contact, select Tools and then Beam Contact, or tap and hold on the file name and select Beam File from the drop-down menu.
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Tasks: Keeping a To Do List
Use Tasks to keep track of what you have to do. To open Tasks, tap , Programs, and then Tasks.

To create a task:
1. Tap New.
2. Using the input panel, enter a description.
3. You can enter a start date and due date or enter other information by first tapping the field. If the input panel is 

open, hide it or use the scrollbar to see all available fields.
4. To assign the task to a category, tap Categories and select a category from the list.
5. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating 

notes, see “Notes: Capturing Thoughts and Ideas” later in this chapter.
6. When finished, tap ok to return to the task list.
To create a task with only a subject line:
1. Make sure Entry Bar is checked on the Tools menu. 

2. To make this task high priority, tap . To make this task low priority, tap . Then tap the entry bar (the field above 
the task list) and enter a title for your new task.

2. Tap the Enter key on the keyboard to add the task to your task list.
Tap to return to Tasks 
list (tasks are saved 

automatically).

Tap each field to enter task information.

Tap to set a due 
date for the task.

Using the Summary Screen
When you tap a task in the task list, a summary screen appears. To change the task, tap Edit.

To beam a task:
1. Select Tools and then Beam Task, or tap and hold on the file name and select Beam File from the  

drop-down menu.
2. Select a device and tap ok.
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Notes: Capturing Thoughts and Ideas
Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with Notes. You can create a written note or a recording. 
You can also include a recording in a note. If a note is open when you create the recording, it will be included in the note as an icon. 
If the note list is displayed, it will be created as a stand-alone recording. To open Notes, tap the Notes icon on the Shortcuts bar, 
located on the Today screen. You can also tap , Programs, and then Notes.

To create a note:
1. Tap New.
2. Add text to your note using one of the input methods.
3. If you wish, add drawing or handwriting to your note with the drawing button on the toolbar.
4. Add voice recording to your note by tapping the Record button on the toolbar.
5. Tap ok. The note is saved automatically.

Creating a new note.

Tap to return to the 
Notes list (notes are 

saved automatically).

To beam a note:
1. Tap Tools and then Beam Note, or tap and hold on the file name and select Beam File from the drop-down menu.
2. Select a destination device and tap ok.
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Messaging: Sending and Receiving E-mail 
Use Messaging to send and receive e-mail in either of these ways: 

• Synchronize e-mail messages with Microsoft Exchange or Microsoft Outlook on your desktop computer.
• Send and receive e-mail messages by connecting directly to an e-mail server through an Internet service provider (ISP) or a 

network.

To open Messaging, press the Messaging button on the front of your iQue M5, or tap  and then Messaging.

Using Messaging
From the main Messaging screen, compose a new message by tapping New. Tap the Inbox drop-down menu to see a tree browser of 
your Messaging folders. Here you can find messages waiting to be sent, messages you have already sent, and deleted messages.

 
Note: It’s a good idea to clear your Deleted Items folder manually from time to time to save storage space. Open your 
Deleted Items folder, tap and hold on each message, and choose Delete from the pop-up menu.

Tap the Sort by drop-down menu (located to the right of the Inbox drop-down menu) to change the listed order of your messages. 
Tap each message to view the message. Tap and hold each message to reply, forward, delete, or move the message.

Using Signatures
A signature is a few lines of text that is automatically included at the bottom of each e-mail you send. Each account can have its 
own signature.

To create a signature:
1. Tap Accounts and then Accounts....
2. Tap the Signatures button.
3. Choose an account from the Select an account drop-down menu that you want to apply the signature to. 
4. Check the box next to Use signature with this account. Check the box if you want to include the signature when 

you reply or forward a message.
5. Enter signature text.
6. Choose another account from the drop-down menu if you want to create multiple signatures.
7. Tap ok.

Creating a new signature.
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Saving vCard (.VCF) Attachments
vCards are electronic business cards—a powerful new means of Personal Data Interchange (PDI) and a way to automate the 
traditional business card. Using vCards with Pocket PC is easy: when you receive these files as e-mail attachments, simply save 
them to your Contacts database.

To save vCards as Contacts:
1.  Open an email with a vCard attachment (.vcf) and tap the attachment.
2.  Tap Yes to save the contact to your Contacts database. 

Synchronizing E-mail Messages
E-mail messages can be synchronized as part of the general synchronization process. You need to enable Inbox synchronization in 
ActiveSync. For information on enabling Inbox synchronization, see “Choosing What Data to Synchronize,” Chapter 2.

During synchronization, messages are copied from the mail folders of Exchange or Outlook on your desktop computer to the 
ActiveSync folder in Inbox on your device. By default, you will receive messages from the past three days only, the first 100 
lines of each message, and file attachments of less than 100 KB in size. E-mail messages in the Outbox folder on your device 
are transferred to Exchange or Outlook, and then sent from those programs. E-mail messages in subfolders must be selected in 
ActiveSync on your desktop computer in order to be transferred. 

Connecting Directly to an E-mail Server
In addition to synchronizing e-mail messages with your desktop computer, you can send and receive e-mail messages by connecting 
to an e-mail server. To connect, you must set up a remote connection to a network or an ISP. For more information, see “Getting 
Connected,” Chapter 6.

When you connect to the e-mail server, new messages are downloaded to your Inbox folder, messages in the device Outbox folder 
are sent, and messages that have been deleted from the e-mail server are removed from your Inbox folder.

Messages that you receive directly from an e-mail server are linked to your e-mail server rather than your desktop computer. When 
you delete a message on your iQue M5, it will also be deleted from the e-mail server the next time you synchronize. See ActiveSync 
to customize synchronization.

You can connect to one e-mail server or several. Before you connect, specify which server you want to connect to.

To connect directly to an e-mail server:
1. Tap Accounts and then New Account....
2. Enter your e-mail address and tap Next. Messaging tries to configure your e-mail settings automatically based on 

your e-mail address.
3. Enter your name, account user name and account password. Check Save Password if you want this password to 

be saved for future connections. Tap Next.
4. Choose whether this account is POP3 or IMAP4 (IMAP4 should be used for standard IMAP and Exchange Server 

accounts). Enter a name for this account. Tap Next.
5. Enter your incoming and outgoing mail servers and the domain name if applicable. Consult your IT department for 

this information. Tap Options to customize your account settings.
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To configure existing e-mail accounts:
1. Tap Accounts and then Accounts....
2. Tap an account from the list of existing accounts. The account wizard opens.
3. Make changes (if you wish) and tap Next until you reach the mail servers page. Tap Options.
4. Choose how often you want to connect to your server and download new messages. Choose whether you want to 

use your Internet profile or your Work profile to connect. Tap Next. For more information on connecting, see “Get-
ting Connected,” Chapter 6.

5. Choose whether your outgoing mail server requires authentication, whether you want to use secure connections, 
and how many messages you want to display. Tap Next.

6. Choose how many of your mail messages you want to download. Tap Finish.
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CHAPTER 4: POCKET OFFICE

Pocket Office on your iQue M5 includes Pocket Word and Pocket Excel. Both programs allow you to create and store different 
types of documents. To open Pocket Word or Pocket Excel, tap , Programs, and then Pocket Word or Pocket Excel.

 
NOTE: For more help with Pocket Office, refer to the help menus by tapping  and then Help from within each program.

Pocket Word
Pocket Word works with Microsoft Word on your desktop computer to give you easy access to your documents. With  
ActiveSync, you can synchronize documents between your desktop computer and your iQue M5 so both have the most  
up-to-date document versions.

Using Pocket Word
You can create new documents in Pocket Word or open existing documents that you have transferred from your desktop computer. 
Pocket Word automatically saves each document when you tap ok to close it. You can also save a document by any name by tapping 
Tools, File, and then Save Document As.

To create a new Pocket Word document:
1. Open Pocket Word by tapping , Programs, and then Pocket Word.
2. If a blank document does not automatically appear, tap New.

You can open only one document at a time. When you open a second document, you are asked to save the first. You can save the 
document in a variety of formats, including Word (.doc), Pocket Word (.psw), Rich Text Format (.rtf), and Plain Text (.txt).

You can change the zoom magnification by tapping View, Zoom, and then selecting the percentage you want. Select a higher 
percentage to enter text and a lower one to see more of your document. If you are opening a Word document created on a desktop 
computer, select Wrap to Window on the View menu so that you can see the entire document without having to scroll from left  
to right.

Zooming in Pocket Word.

On the main screen (no documents open), Pocket Word contains a list of the Pocket Word files stored on your iQue M5. Tap a file in 
the list to open it. To delete, copy, rename, move, send by email, or beam a file, tap and hold on a file name in the list. Then select 
the appropriate action from the pop-up menu.
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Input Modes in Word
When you are working with a document, the View menu allows you to switch between input modes. You have a choice of writing, 
drawing, typing, and recording modes. To change modes, tap View and then tap one of the four modes. For more information on 
entering information, see “Entering Information on Your iQue M5.”

Typing Mode

In Typing mode, use the input panel to enter typed text into the document. To format existing text and to edit text, first select the 
text. You can select text as you do in a Word document, using your stylus instead of the mouse to drag through the text you want to 
select. You can search for text in a document by tapping Edit and then Find/Replace.

Typing Mode

Writing Mode

In Writing mode, use your stylus to write directly on the screen. Ruled lines are displayed as guides, and the zoom magnification is 
greater than in typing mode to allow you to write more easily.

Remember, if you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, which can be edited  
and manipulated.

Writing Mode

Drawing Mode

In Drawing mode, use your stylus to draw on the screen. Gridlines appear as a guide. When you lift your stylus off the screen after 
the first stroke, a drawing box appears indicating the boundaries of the drawing. Every stroke within or touching the drawing box 
becomes part of the drawing.

Drawing Mode

Recording Mode

In Recording mode, embed a recording into your document. Recordings are saved as .wav files and appear as icons embedded in 
your document.

Recording Mode
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Pocket Excel
Pocket Excel works with Microsoft Excel on your desktop computer to give you easy access to copies of your workbooks. With 
ActiveSync, you can synchronize workbooks between your desktop computer and your device so that you have the most up-to-date 
content in both locations.

Working with Pocket Excel
Use Pocket Excel to create spreadsheets, such as expense reports or mileage logs. Pocket Excel automatically saves each document 
when you tap ok to close it. You can also save a document by any name by tapping Tools, File, and then Save Workbook As.

To create a new Pocket Excel file:
1. Open Pocket Excel by tapping , Programs, and then Pocket Excel.
2. Tap New to open a blank spreadsheet.

You can open only one file at a time. When you open a second file, you will be asked to save the first. You can save a spreadsheet 
you create or edit in a variety of formats, including Pocket Excel (.pxl) and Excel (.xls).

Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, sorting, and filtering. To display the toolbar, tap 
 or tap View and then Toolbar. 

For more information on using Pocket Excel, refer to the Microsoft Excel Help file on your desktop computer, or to the help file on 
your iQue M5 (tap  and then Help to access).

Working with Pocket Excel.

Toolbar
Tap to show or 

hide the Toolbar.

On the main screen (no documents open), Pocket Excel contains a list of the Pocket Excel files stored on your iQue M5. Tap a file 
in the list to open it. To delete, copy, rename, move, send by email, or beam a file, tap and hold on a file name in the list. Then select 
the appropriate action from the pop-up menu.
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The software accessories include Microsoft® MSN Messenger, Microsoft® Windows Media Player 10, Microsoft® Terminal 
Services, and Pictures.

MSN Messenger
MSN® Messenger on your mobile device is an instant messaging program that lets you:

• See who is online.
• Send and receive instant messages.
• Have instant message conversations with groups of contacts.

To use MSN Messenger, you must have a Microsoft Passport™ account or a Microsoft Exchange e-mail account. You must have 
a Passport to use MSN Messenger Service. If you have a Hotmail® or MSN account, you already have a Passport. Sign up for a 
Microsoft Passport account at http://www.passport.com. Get a free Microsoft Hotmail e-mail address at http://www.hotmail.com. 
Once you have obtained either a Microsoft Passport or a Microsoft Exchange account, you are ready to use MSN Messenger. To 
open MSN Messenger, tap , Programs, and then MSN Messenger. 

To set up an account and sign in:
1. Launch MSN Messenger. Make sure you are connected to the Internet (see “Getting Connected,” Chapter 6, for 

details).
2. Select Tools > Options and select the Account tab.
3. In the Accounts tab, enter your Passport or Exchange account information. Be sure to indicate which service you 

wish to connect with.
4. To sign in, tap the sign-in screen and enter your e-mail address and password.

Signing in to MSN Messenger.

 
NOTE: In future connections, your information will be already entered in the MSN login screen.

At any time, you can select Tools > Sign Out to disconnect your session. To sign in when disconnected, you can tap the screen or 
you can tap Tools and then Sign In.
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Working with MSN Messenger Contacts
The MSN Messenger window shows all of your messenger contacts at a glance, divided into Online and Not Online categories. 
From this view, you can chat, send an e-mail, block the contact from chatting with you, or delete contacts from your list using the 
pop-up menu.

To add a contact:
1. Tap Tools and then Add a Contact.
2. Enter the name of the user you want to add and tap Next.

To chat with a contact:
1. Tap a contact name to open a chat window.
2. Enter your message in the text entry area at the bottom of the screen, and tap Send.

 
NOTE: To switch back to the main window without closing a chat, tap . To revert back to your chat window, tap Chats 
and select the person with whom you were chatting.

Using My Text
When you are using MSN Messenger, you can use My Text to insert frequently-used words or phrases into the text entry area. To 
insert a message, tap My Text and tap a message. You can add text after inserting a My Text message before sending it.

To edit a My Text message, tap Tools and then Edit My Text. Select the message you wish to edit and make desired changes. Click 
ok to save changes.

Chatting Tips
Keep these tips in mind when you are chatting with contacts:

• To know if the contact you are chatting with is responding, look for the message under the text entry area.
• If the other chat participants are not entering text, the date and time of the last message received appears at the bottom  

of the screen.
• To change how you appear to other users, from either the main Messenger window or a chat window, select Tools > My 

Status. These same choices appear in MSN/Windows Messenger.
• To jump to chats you have active with other users, select Chats and highlight the appropriate contact’s name.



Pocket Accessories: Windows Media Player and Pictures

Chapter 5: Pocket Accessories 35

Windows Media Player for Pocket PC
Use Microsoft Windows Media Player for Pocket PC to play digital audio and video files, including any Windows Media or MP3 
file formats (.asf, .wma, .wmv, .mp3). To open Windows Media Player for Pocket PC, tap the Windows Media icon in the Shortcut 
bar on the Today screen, or tap , Programs, and then Windows Media.

Media Playback
Once you have loaded a media file, you can play, pause, stop, song advance/reverse, mute sound, or adjust volume. Tap the full-
screen mode button to hide the toolbars and show the media in landscape mode. (To return to normal play mode, tap the screen 
again.)

Windows Media Player

Volume indicatorProgress indicator

Tap to open Pocket 
Internet Explorer.

Pictures
Use Pictures to view JPEG pictures stored on your device or in a storage card, send pictures to others, view a slideshow of your 
pictures, or set a picture as the background on the Today screen. You can even set Pictures to launch itself when a digital camera 
storage card is inserted into your device.

To open, tap , Programs, and then Pictures. By tapping and holding on a picture file, you can copy, delete, beam, rename, or 
send the file via e-mail. 

To open Pictures when an SD card is inserted:
1. From within Pictures, tap Tools and then Options.
2. Check the box next to “Detect digital camera storage cards.”

Working with Images
When you open Pictures, a list of all image files in the My Pictures folder of your iQue M5 appears. You can view files on an SD 
card or in Safe Storage by tapping the My Pictures drop-down menu. To view a picture, tap the thumbnail of the picture. Then you 
can rotate, crop, zoom, share, or change brightness and contrast levels of the picture. 

When making changes, you can tap Edit > Undo or Edit > Redo to undo or redo the last change made. To undo many changes at 
once, tap Tools and then Revert to Saved; this step discards all changes since the last save. After you are finished making changes, 
tap Save Picture As in the Tools menu. Keep in mind that the quality of the image may decrease after saving.
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You can use a picture to replace the current background, or wallpaper, on the Today screen.

To set an image as Today wallpaper:
1. Tap Tools and then Set as Today Wallpaper. Pictures automatically crops and resizes the picture to fit the  

Today screen.
2. Select a transparency level. If you have trouble reading text on your Today screen, make the image more transpar-

ent (set the transparency to a larger percentage).

 
NOTE: An improperly sized image appears distorted when applied as wallpaper on the Today screen.

To view images in a slideshow:
1. From the main Pictures window, tap the Slideshow icon .
3. To advance the slideshow, tap anywhere on the screen.
4. To change from vertical to horizontal viewing mode, tap the Flip view icon .

 
NOTE: You can change the slideshow settings by tapping Tools, Options, and then the Slide Show tab.

Terminal Services Client
Using the Terminal Services Client (TSC), you can log onto a desktop computer running Terminal Services (pre-Windows XP) 
or Remote Desktop (Windows XP and later) and use all of the programs available on that computer from your iQue M5. Before 
attempting a Terminal Services connection, you must have authorized access to a desktop or server that supports this service.

To connect to and use Terminal Services Client:
1. Tap , Programs, and then Terminal Services Client.
2. Enter the IP address or host name of a valid TS server. Check Limit size of server… to compress the remote desk-

top screen and minimize scrolling. Tap Connect to start connection.
3. Log in with your username and password.
4. If server desktop size is not in optimized mode, use the “directional” buttons at the bottom of the screen to jump to 

different positions on the screen. You can also tap and hold on the screen to move using a pop-up menu.
5. Use the remote server as you would use your personal computer.

 
NOTE: You must use Keyboard, Block Recognizer, or Letter recognizer to input data when using Terminal Services Client. 
You cannot use Transcriber.
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You can use your iQue M5 to exchange information with the Internet, with a network, or with other mobile devices. You have the 
following connection options:

• Connect to the Internet through your Internet service provider (ISP). Once connected, you can send and receive e-mail 
messages by using Inbox and view Web or WAP pages by using Microsoft® Pocket Internet Explorer. See “Connecting to the 
Internet from a Modem.”

• Connect to the network at your company or organization where you work. Once connected, you can send and receive e-mail 
messages by using Inbox, view Web or WAP by using Pocket Internet Explorer, and synchronize with your desktop computer. 
See “Connecting to a Network.”

• Connect using Infrared (IR) to any other device that uses these technologies. See “Exchanging Data with Mobile Devices.”
• Connect using Bluetooth to any other Bluetooth-enabled device. See Chapter 8, “Using Bluetooth.” 

For information on how to connect and exchange information with your desktop computer, see Chapter 2, “ActiveSync.”

The Connectivity Icons
You can determine the status of your connection from the connectivity icons, which appear in the notification area. Note that some 
of these icons are animated.

Status Icon Meaning
Connected

 or Transferring Data

Not Connected

Synchronizing

Zero–Configuration Internet (The Internet connection has not been configured yet.)

Connecting to the Internet from a Modem
To set up a connection to your ISP, you need to install a modem card or use a NULL modem cable and appropriate adapters to 
connect an external modem to your device through the serial port. You also need the following information: 

• ISP dial-up access telephone number.
• User name. Some ISPs require information in front of the user name, such as “MSN/username.”
• Password. 
• TCP/IP settings. 
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To set up a modem connection to an ISP:
1. Tap  and then Settings. 
2. In the Connections tab, tap the Connections icon. 
3. Under My ISP, tap Add a new modem connection.

4. Enter a name for the connection, such as “My ISP.”
5. In the Select a modem list, select your modem type. If your modem type does not appear, try re-inserting the mo-

dem card. If you are using an external modem that is connected to your device with a cable, select Hayes Compat-
ible on COM1. Tap Next.

Name the connection and select the 
appropriate modem from the list.

6. Enter the number that should be dialed to connect to your ISP. Include any special digits such as “*” or “#”. See 
“Establishing Dialing Rules for Modems” for more information.

7. Enter your ISP username and password, and your Domain, if necessary.

8. To change connection speed or other connection options, tap Advanced.

 
NOTE: You should not need to change any of the settings on the Advanced screen.

9. Tap Finish to complete this wizard.



Getting Connected: Connecting to the Internet from a Modem

40Chapter 6: Getting Connected

To set up a work modem connection:
1. Tap  and then Settings, 
2. Tap the Connections tab and then the Connections icon.
2. Under My Work Network, tap Add a new modem connection.

3. Complete the setup as described above in “To set up a modem connection to an ISP.”

Connecting to your ISP
Open Inbox, Pocket Internet Explorer, or MSN Messenger. Your iQue M5 automatically begins connecting. Once connected, you 
can send and receive e-mail, browse Web pages, and send and receive instant messages.

To connect manually to your ISP:
1. Tap , Settings, the Connections tab, and the Connections icon.
2. Under My ISP or My Work Network, tap Manage Existing Connections.
3. Tap and hold on the applicable dial-up settings and select Connect. To delete the connection, tap Delete.

Establishing Dialing Rules for Modems
To create dialing rules for your modem connection:
1. Tap , Settings, the Connections tab, and then Connections.
2. Tap the Advanced tab and then tap Dialing Rules.
3. To enable dialing rules, tap to check the box next to Use dialing rules. Then tap OK to acknowledge the message 

that appears.
4. Tap to select Home or Work (the dialing rules apply to your ISP or your Work connection, respectively). 
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5. Tap Edit to configure your dialing rules.
6. Enter a name for the dialing profile (if necessary), the country code, and the area code. Tap to disable call waiting. If 

you have a pulse phone, tap Pulse dialing (most phones have tone dialing).

7. Tap Dialing Patterns to change how dialing occurs.
8. Enter how local, long distance, and international calls should be dialed. You can use the following abbreviations: 

E/e represents country code, F/f represents area code, G/g represents a seven-digit phone number. Tap OK to save 
your changes.

Setting up dialing patterns.
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Connecting to a Network
Use a Virtual Private Network (VPN) or a network card to connect to any private network, such as a corporate network that you use 
at work. You can also connect to a network through Bluetooth; see Chapter 8, “Using Bluetooth,” for more information.

Setting up a VPN
A VPN connection helps you securely connect to a server, such as a corporate network, via the Internet. Ask your network 
administrator for your user name, password, domain name, TCP/IP settings, and host name or IP address of the VPN server.

To set up a VPN connection:
1. Tap , Settings, the Connections tab, and the Connections icon.
2. Under the My Work Network heading, tap Add a new VPN server connection.
3. Enter a name for the connection, a host name or IP address, and the VPN type. Then tap Next.

Enter a Host name or IP address.

4. Tap to select whether you want to use a pre-installed certificate or a pre-shared key. Tap Next.
5. Enter your username and password. If necessary, tap Advanced to enter TCP/IP settings and Server DNS/WINS 

information.
6.  Tap Finish.

Connecting to a VPN Server
Open Inbox, Pocket Internet Explorer, or MSN Messenger. Your iQue M5 automatically begins connecting to the Internet. 

To connect manually to a VPN server:
1. From the Connections main window, select Edit My VPN Servers.
2. Tap and hold on your server name and then select Connect. You can also delete your VPN server connection from 

this menu.
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Setting up a Proxy Server
If you are connected to your work connection during synchronization, your mobile device should download proper proxy settings 
during synchronization from your PC. If these settings are not on your PC or need to be changed, ask your ISP or network 
administrator for the proxy sever name, server type, port, type of Socks protocol used, and your user name and password.

To set up a proxy server connection:
1. Tap , Settings, the Connections tab, and the Connections icon.
2. To create a new connection, under the My Work Network heading, tap Add a new proxy server.
3. Select This network connects to the Internet and This network uses a proxy server.

Enter the name of your Proxy server in the field 
above. Tap Advanced to enter more settings.

4. In the Proxy server box, enter the proxy server name. For advanced options, select the Advanced button from the 
Proxy Settings tab. You should get this information from your company’s network administrator.

To change existing proxy server settings:
1. Tap , Settings, the Connections tab, and the Connections icon.
2. Under My Work Network, tap Edit my proxy server and make any necessary changes.

Setting up a Wireless Ethernet Connection
To set up a wireless Ethernet connection, you can use a wireless Ethernet card that is compatible with the iQue M5. You can also 
connect to a network wirelessly by using Bluetooth. See Chapter 8, “Using Bluetooth.”

To set up a wireless Ethernet connection:
1. Insert the wireless Ethernet card into your device. For instructions on inserting and using the Ethernet card, see the 

owner’s manual for the card. When properly inserted, a pop-up message appears.
2. Choose whether the installed network card should be used to connect to The Internet or Work. If you tap OK, you 

automatically accept the default settings for the card and can proceed to step 9 (most home networks allow you to 
get online immediately, without further configuration). If you need to enter a proxy server, tap Settings and enter the 
proxy server information as described above.
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3. To configure the Network Card, tap , Settings, the Connections tab, and the Connections
4. If the network requires a WEP key, a message appears asking you to enter the key.
5. From the IP Address tab, choose to use a server-assigned IP address or a specific IP address. Enter the IP  

address if necessary.
6. Tap the Name Servers tab and enter DNS and WINS settings, if necessary. Then tap ok.

 
NOTE: You must remove and reinsert your network card for these settings to take effect.

6. To view your wireless network connection, tap the Connectivity icon in the notification area. Once your network 
card has been configured, you will connect immediately. 

To turn your wireless network connection on or off:
1. Tap the Connectivity icon and then tap Turn off flight mode to turn on your network card.
2. Tap Turn on flight mode to turn off your network card.

Exceptions for Work URLs
Some companies use periods in their intranet URLs (for example, intranet.companyname.com). If you attempt to connect to one 
of these URLs, Pocket Internet Explorer searches for the Web site in the Internet rather than the company’s intranet. To connect to 
such intranet URLs, they need to be entered as Work URL exceptions.

To create an exception for a work URL:
1. Tap , Settings, the Connections tab, and the Connections icon.
2. From the Advanced tab, tap Exceptions.
3.  Tap Add new URL... to add a new exception. Enter a text string and tap OK.

Enter the URL in the field and tap OK.
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Exchanging Data with Mobile Devices
Your iQue M5 can connect to other handheld devices using Infrared (IR) or Bluetooth technology. Once connected, you can “beam” 
your contact files, appointments, notes, and many other types of files easily, without cords and cables. Beaming means sending 
data electronically from one device to another. For more information on using Bluetooth technology, refer to Chapter 8, “Using 
Bluetooth.”

Beaming Data with IR
Using IR, you can send files from Calendar, Contacts, Tasks, File Explorer, Pocket Word, and Pocket Excel. From within any of 
these applications, you can simply tap Tools and then Beam to beam a file to another device. You can also tap and hold on a file 
name and select Beam from the drop-down menu. Make sure that the Infrared ports are lined up and that there are no objects 
between them.

Infrared (IR) Window

Your iQue M5 automatically receives all incoming Infrared (IR) and Bluetooth beams and asks you whether you wish to accept 
those beams, with the exception of some older devices. To receive beams from older devices, such as a Pocket PC 2000 or H/PC 
device, you must tell your iQue M5 to scan for incoming beams.

To change beam settings:
1. Tap , Settings, the Connections tab, and Beam.
2. Uncheck the Receive all incoming beams checkbox if you never want to receive incoming beams.

To receive beams from older devices (Pocket PC 2000 or H/PC):
1. Tap , Settings, the Connections tab, and then Beam.
2. Tap the Receive an infrared beam link at the bottom of the page.



Pocket Internet Explorer: Chapter 7 Table of Contents

Chapter 7: Pocket Internet Explorer 46

CHAPTER 7: POCKET INTERNET EXPLORER

Browsing the Internet ................................. 47
Displaying Images .................................................... 48
Configuring Pocket Internet Explorer ....................... 48



Pocket Internet Explorer: Browsing the Internet

Chapter 7: Pocket Internet Explorer 47

CHAPTER 7: POCKET INTERNET EXPLORER

Browsing the Internet
You can use Pocket Internet Explorer to browse mobile favorites and channels that have been stored on your iQue M5 without 
connecting to the Internet. You can also connect to the Internet through an ISP or a network connection and browse the Internet.

To store mobile favorites or channels on your iQue M5:
1. From ActiveSync on your desktop computer, click Options.
2. Check the box next to Favorites to automatically synchronize mobile favorites.
3. In Internet Explorer on your desktop computer, browse to a page you want to view on your iQue M5.
4. From the Tools menu, click Create Mobile Favorite.
5. Synchronize your iQue M5 with your desktop computer.

To view mobile favorites and channels:
1. On your iQue M5, tap the Internet Explorer icon  in the Shortcut bar.
2. Tap Favorites  to display the list of favorites you have downloaded.
3. Tap the page you want to view. If a page in the list appears dimmed, it has not been downloaded to your iQue M5. 

You must synchronize with your desktop to download this page. You can also connect to the Internet directly.

To browse the Internet:
1. Set up a connection to your ISP or corporate network. See Chapter 6, “Getting Connected.”

2. Tap the Internet Explorer icon  in the QuickLaunch bar or tap , Programs, Internet Explorer.
3. Tap Favorites , and then tap the favorite you want to view. 
OR
 Tap View and then Address Bar. In the address bar that appears at the top of the screen, enter the Web address 

you want to visit and then tap the Go icon . Tap the down arrow to choose from previously entered addresses.

Favorites
Home

Refresh
Back

Web address



Pocket Internet Explorer: Browsing the Internet

Chapter 7: Pocket Internet Explorer 48

To create favorites directly from the Internet:
1. Open Internet Explorer and then open the page you want to save as a favorite.
2. Tap Favorites and then the Add/Delete tab.
3. Tap New Folder to create a new folder for your favorite. Enter the name and then tap Add.
4. Tap the folder where you want to add your favorite and tap Add.
5. Accept the suggested favorite name and URL or create your own. Tap Add.
6. Tap ok.

Displaying Images
By default, Web pages appear with images loaded. It is a good idea to turn off images when connected over a wireless Internet 
connection if you pay for each megabyte transferred—large images can be expensive to download. To turn off images, tap View and 
then Show Images.

When a Web site is loaded but with images hidden, image placeholders appear. To show individual images, tap and hold on the 
image and choose Show Picture.

Configuring Pocket Internet Explorer
Tap Tools and then Options to change the default home page by using the currently loaded page or the device default. Tap the 
Memory tab to choose how many days of history you want to save. Tap Clear History to remove past history information. On 
this tab, tap Delete Files to remove temporary cached files (such as Web pages and images) to free space on your device. Tap the 
Security tab to turn off cookies, clear cookies, and warn when changing to an insecure page.

 
NOTE: Some Web sites may not render properly if cookies have been disabled. 

Tap Tools and then Options to 
configure Pocket Internet Explorer.
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What is Bluetooth?
Bluetooth is a short-range wireless communications technology. Bluetooth uses radio signals to send and receive information 
quickly and securely from many different types of devices: computers, phones, printers, or any other device that uses Bluetooth 
technology. Using Bluetooth, you can synchronize your iQue M5 with your personal computer, exchange or print files, connect to a 
network, browse the Internet, or listen to music on a Bluetooth headset. To communicate, Bluetooth devices do not have to be in the 
same room, but they must be within 30 feet (10 meters) of each other.

About BTExplorer
BTExplorer is the software on your iQue M5 that helps you connect to other Bluetooth devices. BTExplorer has two modes: Wizard 
mode (the default setting) and Standard mode. Both modes allow you to create and maintain connections with other Bluetooth 
devices, but Wizard mode is designed to simplify this process.

Using either mode, you can view and connect to “services” on other Bluetooth devices. (A service is a type of Bluetooth connection, 
like a serial port connection or a network connection.) Once you create a connection, you can save it as a Favorite, much like you 
would save favorites in your Web browser. Then you can use your Favorites to connect to devices quickly and easily.

 NOTE: You can only connect to other Bluetooth devices that offer services compatible with your iQue M5. If a Bluetooth 
devices does not offer a service that your iQue M5 can connect to, the devices will not connect to each other.

Enabling Bluetooth
Before you can use Bluetooth, you must turn on the Bluetooth transmitter. You can do this easily from the Bluetooth icon on the 
Today screen.

To enable Bluetooth:
1. Tap and hold on the Bluetooth icon  at the bottom right of the screen. A menu appears.
2. Tap Enable Bluetooth. The Bluetooth icon changes from  to  and the blue LED light at the top of your iQue M5 

begins to blink.

Tap Enable Bluetooth on the menu that appears.

To open BTExplorer:
1. Tap the Bluetooth icon .
2. Tap Show BTExplorer.

 NOTE: When you open BTExplorer, you also automatically enable Bluetooth.
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Creating a New Connection in Wizard Mode
When you open BTExplorer for the first time, the program appears in Wizard mode. Use the New Connection Wizard to set up 
connections with other Bluetooth devices and save connections as Favorites. Each time you open BTExplorer, your Favorites are 
listed on this opening screen, and you can use them to reconnect quickly to Bluetooth devices.

BTExplorer, shown in Wizard Mode. Once you 
establish connections with Bluetooth devices, 

shortcuts to those connections are saved on this 
screen as “Favorites.”

To connect to a Bluetooth device, both devices must be turned on, must be within 30 feet (10 meters) of each other, and must be 
“discoverable” (able to receive connections; see “Changing BTExplorer Settings”). 

To create a new connection, tap the New Connection icon , or tap File and then New Connection. Then follow the instructions 
given by the Bluetooth Wizard. Use the Wizard to explore services on other devices if you are not sure what type of connection you 
want to create. Exploring services allows you to view all the Bluetooth devices in the area and what services they offer.

To explore services and create a new connection:
1. From BTExplorer, tap the New Connection icon .
2. Make sure “Explore Services on Remote Device” appears in the drop-down menu. Then tap Next.

“Explore Services on Remote Device”
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3. BTExplorer searches for Bluetooth devices in the area and attempts to discover the names of the devices.  
If nothing happens, or if you want to search again, tap and hold anywhere in the All Devices field and choose  
Discover Devices. You can also select Refresh to delete old Bluetooth devices and search for new devices.

 NOTE: To choose a name for your iQue M5, see “Changing BTExplorer Settings.” The name you choose appears when 
other devices try to connect to your iQue.

BTExplorer searches for devices and for device names. 

If no devices appear, tap and hold,  
then choose Discover Devices.

A list of all Bluetooth devices in the 
area appears in the All Devices field.

4. Tap to highlight the device you want to connect to and then tap Next.
5. Choose the type of connection you want to create from the list of services that appears. For more information on 

individual connections, refer to the information about each connection type later in this chapter.

Tap the service you want to connect 
to and then tap Next.

(Continued on next page)
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6. Make sure the box is checked next to Save as Favorite if you want to create a favorite from this connection. If you 
want to change the name of the connection, tap the Favorite Name field and enter a new name. Then tap Next.

Make sure the box is checked if you want to 
save this connection as a Favorite. Rename the 

Favorite, if you wish.

7. Tap Connect to connect to this Bluetooth device.

For more details and instructions on connecting to specific services, refer to the information that follows for each connection type.

Paring with Another Bluetooth Device
“Paring” means establishing a special relationship with another Bluetooth device. To pair with another device, you must exchange 
a PIN code. After you enter the correct code, your iQue M5 creates a Link Key that establishes that device as a “trusted” device. In 
the future, you can connect to this device automatically, without reentering a PIN code.

To pair with another device:
1. Tap the New Connection icon .
2. Choose “Pair with a Remote Device” from the drop-down menu. Then tap Next.
3. Tap the device you want to pair with and then tap Next.
4. Enter a PIN code in the PIN Code field on your iQue M5. Then enter that same PIN code into the other  

Bluetooth device.
5. Tap Finish.

A PIN code request.
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Setting a PIN Code
You can set a PIN code for your iQue M5 to ensure that all Bluetooth connections are secure. Anyone who tries to pair with your 
iQue M5 must enter the correct PIN code to establish a connection.

To set a PIN code for incoming connections:
1. In Wizard mode or Standard mode, tap Tools and then Settings.
2. Tap the Security tab.
3. Check the box nect to Use PIN Code (Incoming Connections). Then tap the PIN Code field and enter a PIN code.
4. If you want to encrypt outgoing connections (connections you originate), check the box next to Encrypt Link on All 

Outgoing Connections.
5. Tap OK.

Connecting to ActiveSync® with Bluetooth
You can set up a Bluetooth connection between your iQue M5 and your Bluetooth-enabled personal computer to synchronize 
wirelessly—no Sync cradle needed. To synchronize wirelessly with your personal computer, you must have already set up a 
Partnership between your iQue M5 and your personal computer, and you must have already synchronized using your Sync cradle. 
Your personal computer must also offer a Bluetooth Serial Port as a connection service.

To set up ActiveSync for Bluetooth synchronization:
1. Make sure your iQue M5 is not currently connected to your personal computer.
2. Make sure your personal computer offers a Serial Port Bluetooth service. Then determine what serial port the ser-

vice is set to use (for help, refer to the Owner’s Manual for your personal computer or Bluetooth device).
2. Open ActiveSync on your computer.
3. Click File and then Connection Settings.
4. Check the box next to “Allow serial cable or infrared connection to this COM port.” Then choose the COM port used 

by your personal computer’s Bluetooth service (see Step 2).
5. Click OK.

To set up a Bluetooth ActiveSync connection:
1. On your iQue M5, open BTExplorer and then tap the New Connection icon .
2. Choose “ActiveSync via Bluetooth” from the drop-down menu. Then tap Next.
3. Choose your personal computer from the list of devices and then tap Next.
4. BTExplorer automatically selects the appropriate service. If a list of services appears for a device, choose Blue-

tooth Serial Port and then tap Next.
5. If you want to rename the favorite, tap the Favorite Name field and enter a new name. Then tap Next.
6. Tap Connect. Your iQue M5 should automatically begin synchronizing with your computer.



Using Bluetooth: Creating a New Connection in Wizard Mode

55Chapter 8: Using Bluetooth

Connecting to the Internet
You can connect to the Internet on your iQue M5 through any Bluetooth device that has Internet access—a personal computer, a 
network, or even a Bluetooth phone. Determine how the Bluetooth device connects to the Internet, whether through a network or 
through a modem. Then create a connection to the device.

To connect to the Internet using an access point:
1. In BTExplorer, tap the New Connection icon .
2. Choose “Connect to Internet using Access Point.”
3. Choose the access point or computer you want to connect to and then tap Next.
4. BTExplorer automatically selects the appropriate service. If a list of services appears for a device, choose the ser-

vice you want to connect to and then tap Next.

 NOTE: You may see more than one service with the same name, such as Network Access. To choose the correct service, 
you may want to change views. See “Changing Views in Wizard Mode.”

5. If you want to rename the Favorite, tap the Favorite Name field and enter a new name. Then tap Next.
6. Tap Connect. To connect to the Internet, you need to enter network information or proxy server settings. See Chap-

ter 6, “Connecting to a Network” for more information.

To connect to the Interneting using a phone/modem:
1. In BTExplorer, tap the New Connection icon .
2. Choose “Connect to Internet using Phone/Modem.” Then tap Next.
3. Choose the computer or phone you want to connect to and then tap Next.
4. BTExplorer automatically selects the appropriate service. If a list of services appears for a device, choose the ser-

vice you want to connect to and then tap Next.
5. If you want to rename the Favorite, tap the Favorite Name field and enter a new name. Then tap Next.
6. Tap Connect. To connect to the Internet, you need to enter modem information. See Chapter 6, “Connecting to the 

Internet from a Modem” for more information.

Browsing, Sending, or Exchanging Files
If you want to browse or exchange files with another device, you can use the Object Push, PIM Item Transfer, or File Transfer 
services. Object Push and PIM Item Transfer allow you to exchange Contacts or pictures with another device; File Transfer 
allows you to send or receive all types of files.

To browse, send, or exchange files:
1. Tap the New Connection icon .
2. Choose “Send or Exchange Objects” to use the Object Push or PIM Item Transfer services. Choose “Browse Files 

on Remote Device” to use the File Transfer service.
3. Choose the device you want to connect to from the list and then tap Next.
4. BTExplorer automatically selects the appropriate service. If a list of services appears for a device, choose the ser-

vice you want to connect to and then tap Next.
5. If you want to rename the Favorite, tap the Favorite Name field and enter a new name. Then tap Next.
6. Tap Connect.
(Continued on next page)
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To use the Object Push or PIM Item Transfer services:
1. From the page that appears, tap the Action drop-down menu and select an action. Then tap  to choose  

an object.
2. Tap OK. If you receive a contact from another device, that contact is automatically saved in your Contacts list.

Choose a contact to send and then tap OK.

To browse or receive files with the File Transfer service:
1. From the page that appears, browse the root directory of the Bluetooth device you are connected to.
2. To save a file from the device to your iQue M5, tap to highlight the file you want to receive.
3. Tap Actions and then Get File, or tap and hold on the file and choose Get File.
4. Browse to the folder where you want to save the file on your iQue M5. Rename the file if you wish. Then tap Save.

 NOTE: If you have another active Bluetooth connection, you may not be able to receive a file. Disconnect from your other 
Bluetooth device and then try again.

Receiving a file with the File Transfer service. You can rename the file 
and save it anywhere on your iQue M5.

To send a file with the File Transfer service:
1. Tap Actions and then Put File. 
2. Browse to a file on your iQue M5. Tap to highlight the file.
3. Tap Open.
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Sending Contacts, Appointments, and Tasks via Bluetooth
You can send Contacts, appointments, and tasks to another handheld or personal computer from within Contacts, Calendar, or 
Tasks. BTExplorer opens automatically and connects to the handheld or computer you want to send information to.

To send a contact, appointment, or task via Bluetooth:
1. Tap  and then Contacts, Calendar, or Tasks.
2. Tap and hold on a Contact, appointment, or task and select Send over Bluetooth.
3. BTExplorer opens. Select the device you want to send information to and tap Next. (The device you want to send 

information to must support the PIM Item Transfer service.)
4.  Wait while your iQue M5 sends the information to the Bluetooth device. Then tap Finish.

Connecting to a Serial Port
You can establish a serial port connection to another Bluetooth device. The wireless serial connection behaves just like a physical 
cable connection between the two devices.

If you are initiating a serial port connection with another device, your iQue M5 uses the virtual serial port COM 8. If another device 
initiates a serial port connection with your iQue M5, it uses the virtual serial port COM 5.

To connect to a serial port:
1. From Wizard mode, tap File and then New Connection.
2. Choose “Connect Serial Port” from the drop-down menu. Then tap Next.
3. Choose the device you want to connect to from the list and then tap Next.
4. BTExplorer automatically selects the appropriate service. If a list of services appears for a device, choose Blue-

tooth Serial Port and then tap Next.
5. If you want to rename the favorite, tap the Favorite Name field and enter a new name. Then tap Next.
6. Tap Connect.

Connecting to a Personal Area Network
Create a connection to a Personal Area Network (PAN, also called a piconet) to share information with other electronic devices in 
the network. Using this connection, you can communicate directly with other devices or use the PAN to connect to a higher-level 
network or the Internet.

To connect to a PAN:
1. From Wizard mode, tap File and then New Connection.
2. Choose “Connect to Personal Area Network” from the drop-down menu. Then tap Next.
3. Choose the device you want to connect to from the list and then tap Next.
4. BTExplorer automatically selects the appropriate service. If a list of services appears for a device, choose Network 

Access (PAN) you want to connect to and then tap Next.
5. If you want to rename the favorite, tap the Favorite Name field and enter a new name. Then tap Next.
6. Tap Connect.
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Changing Views in Wizard Mode
When working in Wizard mode, you can view Bluetooth Favorites and connections in three different ways: Large icons (default), 
List, and Details. To change views, tap the Views icon  on the toolbar at the bottom of the screen. You can also view active 
connections, trusted devices, and local device properties.

Large Icons View List View Details View

To view your active connections:
1. In Wizard mode, tap Tools and then Active Connections. A list of your active Bluetooth connections appears.
2. To stop an active connection, tap and hold on a connection in the list and choose Disconnect.

To view your trusted devices:
1. In Wizard mode, tap Tools and then Trusted Devices. A list of devices you have paired with appears.
2. To delete the trusted device, delete all trusted devices, or view device properties, tap and hold on a device and 

choose the appropriate action from the menu that appears.

To view your iQue M5 Bluetooth properties:
 In Wizard mode, tap Tools and then Local Device Properties. 
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Using Explorer Mode
In Standard mode, Bluetooth devices, connections, and Favorites appear in ‘‘tree view” (default) or “list view.” Tree view displays 
Bluetooth devices and services in a hierarchy. To view services, connect to Bluetooth devices, or create favorites simply tap and 
hold on a Bluetooth device in the list and choose the appropriate action from the menu. 

In Tree view, devices appear in hierarchical 
lists. To expand a list tap the [+].

Tap  to expand.

Services offered by your 
iQue M5 appear here.

Remote devices are 
categorized as Trusted 
(paired) or Untrusted.

Your Favorite connections 
are listed here.

Tree view, expanded

Using Tree View
In Tree view, you can create connections and save favorites just as you would in Wizard mode. Once you connect to a Bluetooth 
device, the name of the active connection appears bold and highlighted in dark green by default. (You can change the way active 
connections appear; see “To change how active connections appear.”)

To switch from Wizard mode to Explorer mode:
1. Tap View and then Standard Mode.
2. Tap Yes when the pop-up message appears. Note that any active connections are disconnected when you switch 

from one mode to the other.

To discover devices:
 Tap and hold on Remote Devices and choose Discover Devices. The iQue M5 searches for Bluetooth devices 

and displays them under the list of Untrusted Devices.

To discover names:
 Tap and hold on Remote Devices and choose Discover Names. Or, tap and hold on a device listed under Untrust-

ed Devices and choose Retrieve Device Name.

To pair with a device:
 Tap and hold on an Untrusted Device and choose Pair.

To connect to a service:
1. Under Untrusted Devices, tap a device to view the services it offers, or tap and hold and choose Explore.
2. Tap a service to connect to it, or tap and hold and then choose Connect.

To disconnect from a service:
 Tap and hold on an active connection and choose Disconnect.

To create a favorite:
 Tap and hold on an active connection and choose Add to Favorites.
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Changing Views in Explorer Mode
As mentioned previously, you can view Explorer mode in Tree view or List view. You can also display both views at the same time. 

To change views in Standard mode:
 Tap the Explorer Display icon  at the bottom of the screen to change to Tree View, List View, or Both.

When you choose Both from the Explorer 
Display icon, Tree view appears on the top 

and List view appears on the bottom.

Using List View
In List view, Bluetooth devices, services, and Favorites are displayed as icons in a hierarchy similar to that used in File Explorer. To 
move down in the hierarchy (for example, to view Favorites), simply tap an icon. To move up in a hierarchy, tap the Up One Level 
icon . To move up several levels, tap the drop-down menu at the top of the screen and then tap the level you want to view. In List 
view, you can also take advantage of the views available in Wizard mode—List and Details views. To switch to these views, tap the 
Views icon  at the bottom of the screen.

To navigate in List view, tap an icon. Tap the drop-down menu to select a 
different level.

To connect to Bluetooth devices in List mode, tap the device. To disconnect, tap and hold on the device and choose Disconnect. To 
add a connection to Favorites, tap and hold on an active connection and choose Add to Favorites.
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Changing BTExplorer Settings
You may want to change Bluetooth settings on your iQue M5. You can change the name that appears to other devices, make 
incoming connections secure, change what services you offer to other devices, and more. To set a PIN code or encrypt outgoing 
connections, see “Setting a PIN Code.”

To change how you discover devices:
1. In Wizard mode or Explorer mode, tap Tools and then Settings.
2. Tap the Discovery tab. From the Inquiry Length drop-down menu, choose how long you want to search  

for devices.
3. From the Name Discovery Mode drop-down menu, choose whether you want to discover names automatically  

or manually.
4. To delete all discovered devices, tap Delete Devices.
5. To delete all trusted devices, tap Delete Link Keys.

To change your device name:
1. In Wizard mode or Explorer mode, tap Tools and then Settings.
2. Tap the Device Info tab. Then tap the Device Name field and enter a name for your iQue M5.

To prevent devices from discovering and connecting to your iQue M5:
1. In Wizard mode or Explorer mode, tap Tools and then Settings.
2. Tap the Device Info tab. 
3. Choose Non Discoverable from the Discoverable Mode drop-down menu. Choose Non Connectable from the 

Connectable Mode drop-down menu.
4. Tap OK.

To change what services you offer to others:
1. In Wizard mode or Explorer mode, tap Tools and then Settings.
2. Tap the Services tab. 
3. To add a service, tap Add and choose a service from the list. 
4. To delete a service, tap the service in the list and then tap Delete.
5. To view properties for a service, tap the service in the list and then tap Properties.

To change how active connections appear:
1. In Wizard mode or Explorer mode, tap Tools and then Settings.
2. Tap the Miscellaneous tab. (You may need to tap the tab arrows to see Miscellaneous.)
3. From the Highlight Connections drop-down menu, choose whether you want to highlight active connections  

or not. 
4. Under Highlight Attributes, choose a text style and text color to highlight active connections.

To view BTExplorer software information:
 From Wizard or Explorer mode, tap File and then About. Tap OK to exit.
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CHAPTER 9: USING SPRITE BACKUP

Sprite Backup helps you protect the data on your iQue M5 from loss due to hardware failure, drained battery, or accidental deletion. 
Use Sprite Backup to save a backup copy of your data in a safe location. Then if you erase or overwrite data or lose all battery 
power, you can easily restore the data from your backup copy.

Use Sprite Backup to protect your data in the following ways:
• Back up and restore all data on your iQue M5. 
• Back up and restore selected files, folders, mail items, and databases. 
• Back up data automatically when your battery is running low. 
• Schedule automatic regular backups.

About Sprite Backup
Sprite Backup can operate in two different modes: Basic Mode and Advanced Mode. Basic Mode, the default mode, has a straight-
forward interface that displays the date and time of your last backup and allows you to back up and restore all data on your iQue 
M5 with a single tap. Advanced Mode is designed for users with specific backup requirements. Advanced Mode allows you to select 
items to exclude from backups, enable encryption and compression, and maintain existing backup files automatically.

To switch from Basic Mode to Advanced Mode:
 Tap Options and then Switch to Advanced Mode.

Backing Up Data in Basic Mode
As mentioned previously, Basic Mode allows you to back up all data on your iQue M5 with a single tap. The backup process may 
take several minutes, depending on how much data is stored on your iQue. Once the backup operation begins, do not remove any 
storage cards or attempt to use any other programs until the operation is complete. 

To back up data in Basic Mode:
1. Tap Backup Now on the Sprite Backup main screen.
2. Wait while Sprite Backup saves data. When the “Operation Completed” message appears, tap OK. Tap View Re-

port to view the backup report (see “Viewing Backup History”).
3. Tap OK when the pop-up message appears to restart your iQue M5.

Backing up data in Basic Mode.
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Restoring Data in Basic Mode
Basic Mode also allows you to restore all data quickly and easily. Restoring data may take several minutes, depending on how much 
data is stored in the backup file. Once the restore operation begins, do not remove any storage cards or attempt to use any other 
programs until the operation is complete.

To restore data in Basic Mode:
1. Tap Restore Now on the Sprite Backup main screen. 
2. Wait while Sprite Backup restores data. When the “Operation Completed” message appears, tap OK.
3. Tap OK when the pop-up message appears to restart your iQue M5.

Restoring data in Basic Mode.

Tips for Using Basic Mode
Keep the following tips in mind when using Basic Mode:

• Basic Mode automatically uses any options you set in Advanced mode, such as compression and encryption settings. If you 
want to reset Sprite Backup settings, tap Options and then Reset Sprite Backup Settings. Note that this action does not 
cancel any scheduled backups or deactivate battery monitoring.

• If you want to restore data using a backup file other than the default file, you must switch to Advanced Mode. See “Backing 
Up Data in Advanced Mode.”

• Basic Mode automatically determines where to store backup files. The file is saved on a storage card if present, in Safe 
storage, or in main memory. If you want to save the backup file in a different location, you must switch to Advanced Mode. 
See “Backing Up Data in Advanced Mode.”

Synchronizing after Restoring Data 
When you try to synchronize your iQue M5 with your computer after restoring data from a Sprite Backup operation, you may 
receive a message like this: “The following information type on your mobile device has items that have not been synchronized 
with this computer before.” This message is expected and unavoidable, even though you have already synchronized data with 
your computer in the past. Choose Combine to add the information on your PC to that on your iQue M5. Replace removes all 
entries from your iQue M5 and resynchronizes everything. In most cases, we recommend that you choose Combine; if you choose 
Replace, you may important delete information that you just restored from Sprite Backup.
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Backing Up Data in Advanced Mode
In Advanced Mode, the backup page is separated into two sections. The top section contains a list of all the files you can include in 
your backup file. The bottom section displays the name of your last backup file and the location where it is saved.

Remember, once you have begun the back up process, do not remove any storage cards or attempt to use any other programs until 
the operation is complete.

To back up files in Advanced Mode:
1. Select which items you want to include in your backup file by tapping each item to remove or add a red checkmark. 

To expand the file list, tap the [+] next to each item.
 • A red checkmark means all items and sub-items in a list are included in the backup file.
 • A gray checkmark means some sub-items are not included in the backup file.
 • No checkmark means the item and sub-items are not included in the backup file.
2. Tap the Browse icon . Then tap the Name field and enter a name for the backup file, if you wish. Tap the Loca-

tion drop-down menu and choose a location where you want to save the backup file.
3. Tap the Backup File Description field and enter a description for the backup file, if you wish. Then tap OK.
4. Tap Backup.

Backing up data in Advanced Mode.

5. Review the settings you have selected. Then tap Start.
6. Wait while Sprite Backup backs up data. When the “Operation Completed” message appears, tap OK. Tap View 

Report to view the backup report (see “Viewing Backup History”).
7. Tap OK when the pop-up message appears to restart your iQue M5.
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Setting Options for Backup
Set specific backup options to further customize the way Sprite Backup saves your files. You can compress, encrypt, automatically 
name and maintain backup files, and configure many other backup options.

Compress Backup—Compresses all new backup files so that they take up less storage space. Backup operations take longer when 
you choose this option, especially if you are backing up files that are already compressed, such as image or music files. 

Encrypt Backup—Encrypts and password-protects all new backup files. When you create an encrypted backup file, you must enter 
a password that is alphanumeric and between six and fifteen characters long. When you restore the backup file, you must reenter the 
password. Note that encryption only applies to manual backup operations (not scheduled or automatic backups).

Stop Processes Before Backup—Causes Sprite Backup to close all applications that are open before beginning a backup operation. 
It is a good idea to leave this option checked because it ensures that Sprite Backup can back up all necessary files.

Exclude Specific file types—Excludes all files of the type you specify from all backup operations. 

Name Backup Files Automatically—Automatically creates a name for each backup file based on the current date.

Maintain prior backup files—Manages the amount of space taken up by existing backup files. This option prevents saved backup 
files from taking up large amounts of space.

Create self-restoring Backup Files—Creates all new backup files as self-restoring files, which means you can restore files on a 
Pocket PC without having Sprite Backup installed. These files run automatically from File Explorer and are larger than ordinary 
backup files. 

To set backup options in Advanced Mode:
1. Tap Options and then Backup Options.
2. Change settings as necessary. 
3. To restore default settings, tap Default.
4. Tap OK.

Setting backup options in Advanced Mode.
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To exclude file types from backup operations:
1. Tap Options and then Backup Options.
2. Tap Edit Exclusion List....
3. Tap to check or uncheck items you want to exclude from backups. 
4. To exclude more specific file types or files, tap the Custom field and type a file type or folder name. Then tap Add.

• Enter a folder name to exclude all items in that folder (example: \Temp excludes all files and folders in the  
Temp folder).

• Enter a folder name with a wildcard specifier to exclude all items in that folder but include all items in any sub-
folders (example: \Windows\*.*).

• Enter a folder name with a wildcard plus extension to exclude all files of that type in the folder (example: \Win-
dows\*.dll excludes all .dll files in the Windows folder).

• Enter a wildcard plus extension name to exclude all files of that type in all folders (example: *.msg).
5. To delete custom files, tap to highlight the file name and then tap Delete.
6. To restore default settings, tap Default.
7. Tap OK.

To set maintenance options for backup files:
1. Tap Options and then Backup Options.
2. Check the box next to Maintain prior backup files. Then tap Options....
3. Check or uncheck boxes for maximum amount of space and maximum number of backup files. Then, if necessary, 

specify the maximum amount of space and the maximum number of files.
• Check “Maximum amount of space to use in the destination folder...” to limit the amount of space taken up by 

backup files to the amount you specify. Sprite Backup deletes old backup files (oldest first) if necessary to cre-
ate space for new backup files.

• Check “Maximum number of backup files to keep...” to limit the number of files that Sprite Backup saves in the 
destination folder. Sprite backup deletes old backup files (oldest first) to ensure that there are no more than the 
specified number of files present.

4. Tap OK.

Restoring Data in Advanced Mode
In Advanced Mode, the restore page allows you to choose the backup file you want to use to restore files and settings. You can view 
a description for the backup file if you entered one previously. You can also view a list of all files included in the backup file and use 
the list to restore files selectively.

To restore all data in Advanced mode:
1. Tap the Restore tab.
2. Tap the Browse icon  to choose the backup file you want to use to restore data. Tap to highlight the file and then 

tap Open.
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3. Tap Restore. Review your settings at the top of the page. Then tap Start.

Restoring files in Advanced Mode.
4. Wait while Sprite Backup restores data.
5. Tap OK when the pop-up message appears to restart your iQue M5.

To restore specific files:
1. Tap the Restore tab.
2. Tap the Browse icon  to choose the backup file you want to use to restore data. Tap to highlight the file and then 

tap Open.
3. Tap to uncheck all items in the list on the Restore page. To expand the file list, tap the [+] next to each item. Then 

use the list to browse to the files you want to restore and check the boxes next to those files.
4. Tap Restore. Review your restore settings, and then tap Start. 
5. Tap OK when the pop-up message appears to restart your iQue M5.

Setting Restore Options
Set restore options to customize the way Sprite Backup restores your data. By default, both restore options are enabled:

Stop Process Before Restore—Causes Sprite Backup to close all applications that are open before beginning a restore operation. It 
is a good idea to leave this option checked because it ensures that Sprite Backup can restore and overwrite files (if necessary).

Automatic Menu Handling—Allows Sprite Backup to automatically correct any problems that may arise when restoring the Start 
Menu. Specifically, Sprite Backup prevents unmovable duplicate menu items from appearing in the Start Menu after restoring data. 
Deselect this option only if you want to restore individual Start Menu items rather than the entire Start Menu.

To set restore options in Advanced mode:
1. Tap Options and then Restore Options.
2. Tap to check or uncheck the options you want.
3. To restore default settings, tap Default.
4. Tap OK.
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Scheduling Automatic Backups
You can schedule Sprite Backup to perform a backup of your data automatically on a specific date and time (can be recurring). Note 
that the backup file includes all data on your iQue M5 except those files you have excluded in Backup Options. Also note that any 
automatic backups are not encrypted. See “Setting Backup Options” for more information.

To schedule automatic backups:
1. Tap Options and then Scheduled Backup.
2. Tap to check Enabled Scheduled Backup.
3. Tap to select a frequency for the backup.
4. Tap the arrow to the right of the date to select a date from the calendar.
5. Tap the hour and minute numbers in the Time field and then tap the up and down arrows to change the time.
6. Tap the Browse icon  to choose the location and folder where you want to save the backup file.
7. Tap to check the box if you want to restart your iQue M5 when the backup is complete.
8. Tap OK.

 NOTE: The location you select for the backup file must be available for backup operations to proceed. If the selected loca-
tion is not available (not enough storage space), then the automatic backup will be cancelled.

Scheduling an automatic backup.

Monitoring Your Battery
Sprite Backup can monitor your battery level and automatically notify you when the remaining battery life drops below a certain 
level. The battery notification is similar to notifications that appear for upcoming appointments. You can dismiss the notification, 
snooze, or tap Run to back up your data. You can also choose to back up your data automatically without notification if the battery 
life drops below a certain level. Note that the backup file includes all data on your iQue M5 except those files you have excluded in 
Backup Options. Also note that any automatic backups are not encrypted. See “Setting Options for Backup.”
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To enable battery monitoring:
1. Tap Options and then Battery Monitoring.
2. Tap to check the box next to Monitor the battery life of this device.
3. Tap to back up automatically or receive a backup prompt (notification).
4. Choose the battery life level at which you want to back up data or display a backup prompt. The level you choose 

must be between 10 and 90 percent.
5. Tap the Browse icon  to choose the location and folder where you want to save the backup file.
6. Tap OK.

Backing Up and Restoring PIM Data Automatically
Sprite Backup can back up PIM (Personal Information Manager) data to safe storage automatically, so that any changes to your 
Calendar and Contacts are saved and cannot be erased by power loss or hard reset. When you hard-reset your iQue M5, your 
Calendar and Contacts are automatically restored.

To enable automatic backup and restore of PIM data:
1. Tap Options and then PIM Mirroring.
2. Tap to check the box next to Enable PIM Mirroring.

Viewing Backup History
The Backup History page displays the date and time of the thirty most recent backup files created. You can also view a detailed 
backup history, called a backup report, which contains details about each backup operation.

To view backup history:
1. Tap Options and then View Backup History.
2. Tap a date and time to view the backup report for that specific backup operation.

Disclaimer
Regardless of whether any remedy set forth herein fails of its essential purpose, in no event will Sprite Software be liable to you for 
any special consequential, indirect or similar damages, including any lost profits or lost data arising out of the use or inability to use 
the software even if Sprite Software has been advised of the possibility of such damages.

Some states do not allow the limitation or exclusion of liability for incidental or consequential damages so the above limitation or 
exclusion may not apply to you.

In no case shall Sprite Software’s Liability exceed the purchase price for the software. The disclaimers and limitations set forth 
above will apply regardless of whether you accept the software.



Customizing Your iQue M5: Chapter 10 Table of Contents

71Chapter 10: Customizing Your iQue M5

CHAPTER 10: CUSTOMIZING YOUR IQUE M5
Changing Personal Settings ........................... 72

Viewing iQue M5 Information ......................... 75

Configuring Backlight and Power Settings ... 76

Changing System Settings ............................. 77
Configuring Regional Settings ....................................... 78
Removing Programs ....................................................... 78
Changing Screen Settings ............................................... 79



Customizing Your iQue M5: Changing Personal Settings

72Chapter 10: Customizing Your iQue M5

CHAPTER 10: CUSTOMIZING YOUR IQUE M5
You can customize your iQue M5 by adjusting personal settings and system settings. Personal settings allow you to change things 
like sounds, passwords, and menus. System settings allow you to adjust backlight and power settings, change system time, change 
memory settings, and more. Choosing the correct system settings can also help save battery power.

Changing Personal Settings
To customize Buttons:
1. Tap , Settings, and the Buttons icon.
2. Tap the button in the list you want to change. Then choose the program from the Assign a program drop-down 

menu that you want to open when you press that button.
3. Tap the Up/Down Control tab to change the way your Up and Down buttons (Scroll button on the front of your 

iQue M5) operate.
4. Tap the Advanced tab to change the way the Que button operates. For more information, refer to the Que  

Applications Guide.

Changing Button settings.

To customize the Input Panel:
1. Tap , Settings, and the Input icon.
2. Choose an input method from the drop-down menu. Then tap Options, or tap to configure settings (for the  

Keyboard).
3. Tap the Word Completion tab to turn word completion on or off and configure settings.
4. Tap the Options tab to change more settings including voice recording format and zoom options.

Changing Input Panel settings.
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To place programs in the Start Menu:
1. Tap , Settings, and the Menus icon.
2. Tap to place a checkmark next to the programs you want to appear in your Start menu. If you do not want a  

program to appear, uncheck the box. Unchecked programs appear under , Programs.
3. Tap the New Menu tab and then check the box next to Turn on New button menu to activate the New menu 

(found on the Today page at the lower left corner of the screen). Tap to check or uncheck programs you want to ap-
pear in this menu. 

Changing Start menu and New menu settings.

To set Owner Information:
1. Tap , Settings, and the Owner Information icon.
2. Tap each field and enter your personal information.
3. Tap the Notes tab and enter any notes you want to display.
3. Tap the Options tab and check the boxes if you want to display your personal information or notes each time you 

turn on your iQue M5.

Entering Owner Information.
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To set a password:
1. Tap , Settings, and the Password icon.
2. To activate a password, tap to check the box next to Prompt if device unused for. Then, from the drop-down list, 

select how long you want your iQue M5 to sit idle before it asks for a password.
3. Choose a password type from the Password type drop-down menu.
4. Enter the password. If you chose Simple 4 digit as the password type, you must enter a four-digit number. If you 

chose Strong alphanumeric, reenter the password in the Confirm field.
5. Tap the Hint tab and enter a hint to help you remember your password.
5. Tap ok. Then tap Yes to confirm your changes.

A simple password, a strong password, and a password hint.

To change or delete a password:
1. Tap , Settings, and the Password icon.
2. Enter your password.
3. Change your password to a new password. To stop using a password, uncheck the box next to Prompt if device 

unused for.

To change sounds:
1. Tap , Settings, and the Sounds & Notifications icon.
2. Tap to check boxes for the sounds you want to hear and uncheck boxes for the sounds you want to silence.

 
NOTE: You can adjust the volume from the Today page by tapping  and dragging the slider bar up or down.

To change notifications:
1. Tap , Settings, and the Sounds & Notifications icon. Then tap the Notifications tab.
2. Tap the Event drop-down menu to choose an event.
3. Tap to check or uncheck the Play sound box. Tap to check or uncheck other notification settings as needed.

The Sounds tab. The Notifications tab.
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To change the Today screen theme:
1. Tap , Settings, and the Today icon.
2. Select a theme from the list that appears. To use a picture as the background, check the box next to Use this picture 

as the background. Then tap Browse to select a picture on your iQue M5.
3. Tap the Items tab and check or uncheck boxes to choose what appears on the Today screen. Tap an item and then 

tap Move Up or Move Down to change the order in which items appear.
4. Tap Intellidate, QuickLaunch, GPS Info, Calendar, or Tasks and then tap Options to specify how these items appear 

on the Today screen.
5. If you want the iQue M5 to display the Today screen when turned on, tap Today timeout. Then choose a time from 

the drop-down menu (the Today screen appears when the iQue M5 is turned on after sitting idle for this amount  
of time).

Changing the appearance of the Today screen.

Viewing iQue M5 Information
You can view detailed information about your iQue M5 from two system settings programs: About and Assets. About shows you 
information about the Windows Mobile™ software and copyrights on your iQue M5 and allows you to change the device name for 
use with ActiveSync. Assets displays detailed information about the iQue M5 hardware and included Garmin software.

To view About or Assets:
1. Tap , Settings, and the System tab.
2. Tap About or Assets. To view information in About, tap each tab. To view information within Assets, expand each 

topic by tapping .

To change the device name:
1. Tap , Settings, and the System tab.
2. Tap About and then the Device ID tab. Then enter a new name in the Device name field and tap ok.
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You can also view information about device Certificates from system settings. A certificate is a file that helps you identify yourself 
to secure networks (personal certificates) or helps you identify servers you may connect to (root certificates).

To view certificates:
1. Tap , Settings, and the System tab.
2. Tap the Certificates icon. View your personal certificates. Tap the Root tab to view root certificates.
3. To delete a certificate, tap and hold on a certificate in the list and choose Delete.

Configuring Backlight and Power Settings
Changing Backlight and Power settings properly can help you save battery life! If you keep the backlight or your iQue M5 on for 
long periods of time, you will use up battery power very quickly. Remember to turn off the backlight and your iQue M5 when you 
are not using them to save battery power. 

To change Backlight settings:
1. Tap , Settings, the System tab, and the Backlight icon.
2. From the Battery Power tab, tap the drop down menu to select how much time should pass before the backlight 

turns off when using battery power.
3. Tap the External Power tab. Tap to check the box if you want the backlight to turn off when the device is run by 

external power (like your automotive cradle or your desk cradle). Tap to select how much time you want to elapse 
before the backlight turns off.

4. Tap the Brightness tab. Choose the brightness level you want the backlight to have.

Changing Backlight settings.

To change Power settings:
1. From the Backlight screen, tap the blue power link at the bottom of the screen.
OR
 Tap , Settings, the System tab, and then the Power icon.
2. View the current battery power remaining.
3. Tap the Wireless tab to turn wireless signals on or off.
4. Tap the Advanced tab to turn off the device if idle. Choose a time from the drop-down menu. After the iQue M5 is 

idle for this amount of time, the unit will turn off automatically.
5. Tap the Sleep tab to wake up the device by pressing buttons or to enable GPS Standby mode.
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Changing System Settings
To change bass boost settings:
1. Tap , Settings, and the System tab.
2. Tap the Audio icon. Drag the slider to adjust bass boost settings.

To change microphone settings:
1. Tap , Settings, the System tab and then the Audio icon.
2. Tap the Microphone tab. Then tap to configure the microphone gain for various situations. If you choose a custom 

gain setting, drag the slider at the bottom of the screen to adjust the gain.

To change the time:
1. Tap , Settings, the System tab, and the Clock & Alarms icon. 
2. Tap to choose whether you want to set Home time or Visiting time.
3. Choose a time zone from the drop-down menu.
3. To change the time, tap to highlight the hour showing in the Time field. Tap the up arrow or down arrow to change 

the hour. Tap to change minutes, seconds, and AM or PM in the same way.
4. Tap the arrow next to the date to choose a date from the calendar. Or tap each number in the date and enter new 

information using the Input Panel.
5. Tap ok.

 
NOTE: You can also change the time by tapping the Date and Time displayed on the Today screen.

Changing the time.

To set an alarm:
1. Tap , Settings, the System tab, and the Clock & Alarms icon.
2. Tap the Alarms tab.
3. Tap to check the first box to set an alarm. Next to the box, tap < Description > and enter a name for the alarm.
4. To select a day of the week for the alarm to go off, tap a letter underneath the alarm name. Tap multiple letters to 

select multiple days. Tap a selected letter to remove that day.
5. Tap the time to set the time you want the alarm to go off. Tap the bell to customize the way the alarm goes off.
6. Repeat steps 3-6 for each new alarm you want to set. 
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Setting an alarm.

Tap to change how 
the alarm goes off.

To view memory available and change how memory is allocated:
1. Tap , Settings, the System tab, and the Memory icon. 
2. Drag the slider to adjust how much memory is allocated to Storage and Programs.
3. Tap the Storage Card tab to view how much memory is free in Safe Storage and on your Secure Digital (SD) card.
4. Tap the Running Programs tab to view what programs are running. Tap a program and then tap Activate to view 

the program or tap Stop to close the program. Tap Stop All to close all running programs.

Configuring Regional Settings
This control panel allows you to change how data appears on your iQue M5, such as currency, times, dates, and numbers. Pocket 
PC comes pre-installed with many international regional setting profiles, but all can be configured to your needs.

To change Regional Settings:
1. Tap , Settings, the System tab, and the Regional Settings icon.
2. Tap the drop down menu to select the language you want to appear on your iQue M5.

 
NOTE: This language setting does not affect icon or program names; it only changes dates, numbers, and other data  
you enter.

3. Tap the Number, Currency, Time, and Date tabs to change the way these things appear on your iQue M5. You may 
need to reset your iQue M5 for these settings to take effect.

Removing Programs
Use Remove Programs to uninstall programs from your iQue M5 that you have installed into storage memory. Note that you cannot 
uninstall programs that came included with your iQue M5.

To remove programs:
1. Tap , Settings, the System tab, and the Remove Programs icon. 
2. Tap the program in the list that you want to remove. Then tap Remove. 

Tap Yes when the warning message appears.

Tap Yes to begin removing a program.
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Changing Screen Settings
Occasionally, your touch display might not respond correctly to stylus or finger taps. If this happens, try aligning the screen.

To align the screen:
1. Tap , Settings, the System tab, and the Screen icon. 
2. Tap the Align Screen button.
3. Follow the instructions on the screen.

Aligning the screen.

You can change the screen orientation on your iQue M5 from portrait mode (default) to landscape mode.

To change screen orientation:
1. Tap , Settings, the System tab and the Screen icon.
2. Tap to change the screen to Landscape (left or right-handed) or Portrait mode. 

 
NOTE: Some programs work best in Portrait mode. If you have trouble using a program, try switching to Portrait mode.

Enable ClearType if you want to control how fonts appear on your iQue M5 screen. You can also adjust ClearType with the 
ClearType Tuner.

To enable ClearType:
1. Tap , Settings, the System tab, and the Screen icon.
2. Tap the ClearType tab. Then check the box to enable ClearType.

To use the ClearType tuner:
1. Tap , Settings, the System tab, and the ClearType Tuner icon. 
2. Drag the slider until the text looks clear. Then tap ok.

To change screen text size:
1. Tap , Settings, the System tab and the Screen icon.
2. Tap the Text Size tab. Then drag the slider to increase or decrease the text size that appears in most programs.
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